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Πρόλογος 

 

Ζ ξαγδαία ηερλνινγηθή αλάπηπμε ησλ ηειεπηαίσλ εηψλ έρεη επηθέξεη ζεκαληηθέο 

αιιαγέο ζηνλ ηξφπν επηθνηλσλίαο. Έλαο απφ ηνπο ρψξνπο πνπ έρεη επεξεαζηεί ζε 

κεγάιν βαζκφ απφ ηηο ηερλνινγηθέο εμειίμεηο είλαη θαη εθείλνο ηεο εθπαίδεπζεο, ζηνλ 

νπνίν, ηα ηειεπηαία ρξφληα, παξαηεξείηαη κηα ζεκαληηθή ζπκπιήξσζε ηεο ζπκβαηηθήο 

δηαδηθαζίαο εθπαίδεπζεο κε κηα πην γεληθή θαη επέιηθηε, εθείλε ηεο εμ απνζηάζεσο 

εθπαίδεπζεο ή ηειεθπαίδεπζεο.  

 Γεληθά, κπνξνχκε λα πνχκε φηη ε ηειεθπαίδεπζε, είλαη ε εθπαηδεπηηθή δηαδηθαζία 

απφ απφζηαζε, ε νπνία φκσο πξαγκαηνπνηείηαη κε ηε ρξήζε ησλ λέσλ ηερλνινγηψλ 

θαη ζπλδέεηαη άξξεθηα κε ηηο επηθνηλσληαθέο δπλαηφηεηεο πνπ πξνζθέξεη ζήκεξα ην 

Γηαδίθηπν.  

 Ζ ηειεθπαίδεπζε ρξεζηκνπνηεί εξγαιεία πνπ βαζίδνληαη ζε έλα πιήζνο 

εθαξκνγψλ ηεο πιεξνθνξηθήο, κε απψηεξν ζθνπφ λα κεηαηξέςεη ηηο ζειίδεο ελφο 

βηβιίνπ ζε εθπαηδεπηηθφ πιηθφ πνιιαπιψλ αλαπαξαζηάζεσλ, ζπλδπάδνληαο ήρν, 

εηθφλα, video, παξέρνληαο αχμεζε ηεο πνηφηεηαο, απνηειεζκαηηθφηεηαο θαη επειημίαο 

ηεο εθπαίδεπζεο. Έηζη, δίλεηαη ε δπλαηφηεηα είηε ζε κεκνλσκέλα άηνκα είηε ζε 

ζπγθεθξηκέλεο θνηλσληθέο ή επαγγεικαηηθέο νκάδεο λα ηθαλνπνηήζνπλ ηηο ηδηαίηεξεο 

θαη πνιχπιεπξεο αλάγθεο ηνπο γηα πεξαηηέξσ κφξθσζε. 

 Σηφρνο ηεο παξνχζαο πηπρηαθήο εξγαζίαο είλαη αθελφο ε παξνπζίαζε ησλ ζηαδίσλ 

πνπ απαηηνχληαη γηα ηε δεκηνπξγία πνιπκεζηθήο εθαξκνγήο απηνδηδαζθαιίαο, θαη 

αθεηέξνπ ε αλάπηπμε θαη ε πινπνίεζε κηαο ηέηνηαο εθαξκνγήο, έρνληαο σο ζέκα ηε 

δηδαζθαιία ηνπ ζρεδηαζηηθνχ παθέηνπ AutoCAD. 

 Ζ παξνχζα πηπρηαθή εξγαζία εθπνλήζεθε ζην πιαίζην ηνπ ζρεηηθνχ καζήκαηνο 

ηνπ Τκήκαηνο Πιεξνθνξηθήο, ηεο ζρνιήο Τερλνινγηθψλ Δθαξκνγψλ ηνπ 

Αιεμάλδξεηνπ Τερλνινγηθνχ Ηδξχκαηνο Θεζζαινλίθεο, ππφ ηελ επίβιεςε ηνπ θ. Φψηε 

Κφθθνξα,  Δπηζηεκνληθνχ Σπλεξγάηε ηνπ ΤΔΗ Θεζζαινλίθεο.  
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 Θα ήζεια λα επραξηζηήζσ πνιχ ηνλ θαζεγεηή κνπ πνπ κε πνιιή ππνκνλή κε 

ελζάξξπλε λα ζθέθηνκαη ζεηηθά θαη λα ςάρλσ ζε βάζνο γηα έλα θαιχηεξν απνηέιεζκα 

θαη ηνπο θίινπο κνπ πνπ κε ζηήξημαλ θαη ζηάζεθαλ δίπια κνπ, εηδηθά ηα πξψηα ρξφληα 

πνπ ήηαλ θαη ηα πην δχζθνια. 

Ακπέζε Νεξηήιηα 

Μάξηηνο 2010 
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Περίληυη 

Ζ επηξξνή ηεο ηερλνινγηθήο εμέιημεο ζηνλ ρψξν ηεο εθπαίδεπζεο απνηειεί 

αλακθηζβήηεηε πξαγκαηηθφηεηα, πνπ ζθνπφ έρεη ηε κεξηθή απηνκαηνπνίεζε ηεο 

δηδαζθαιίαο θαη ηε δηεπθφιπλζε ηεο κάζεζεο.  

 Έρεη αλαπηπρζεί, θαη ζπλερίδεη λα αλαπηχζζεηαη, πιεζψξα ππεξεζηψλ θαη 

εθαξκνγψλ, νχησο ψζηε λα επηηεπρζεί ε απηνκαηνπνίεζε θαη ε επειημία ηεο 

εθπαηδεπηηθήο δηαδηθαζίαο. Μηα ηέηνηα εθαξκνγή απνηεινχλ θαη νη Πνιπκεζηθέο 

Δθαξκνγέο Απηνδηδαζθαιίαο, νη νπνίεο αμηνπνηψληαο ηηο ππάξρνπζεο ηερλνινγίεο, 

πξνζθέξνπλ έλα πινχζην, ειθπζηηθφ θαη επέιηθην εθπαηδεπηηθφ πεξηβάιινλ, πνπ 

επλνεί ηελ εξεπλεηηθή, ηελ ελεξγεηηθή θαη δεκηνπξγηθή κάζεζε.  

 Ζ παξνχζα πηπρηαθή εξγαζία απνζθνπεί ζηε δεκηνπξγία θαη παξνπζίαζε κηαο 

πνιπκεζηθήο εθαξκνγήο απηνδηδαζθαιίαο, πνπ αλαθέξεηαη ζην ζρεδηαζηηθφ παθέην 

AutoCAD. Αξρηθά γίλεηαη κηα επηζθφπεζε ηεο εθαξκνγήο AutoCAD, παξνπζηάδνληαο 

ηηο πην ζεκαληηθέο ιεηηνπξγίεο ηεο. Αθνινχζσο γίλεηαη αλαθνξά ζηελ εθαξκνγή 

Camtasia, κέζσ ηεο νπνίαο έγηλε ε ζχιιεςε φισλ ησλ βίληεν πνπ απαηηνχληαη γηα ηελ 

εθκάζεζε ηνπ AutoCAD. Σηε ζπλέρεηα παξνπζηάδεηαη ην ινγηζκηθφ eXe κε ηε 

βνήζεηα ηνπ νπνίνπ γίλεηαη ε ελνπνίεζε θαη ε παξαγσγή ηεο νινθιεξσκέλεο 

πνιπκεζηθήο εθαξκνγήο. Δπηπξφζζεηα αλαθέξνληαη θάπνηα εμεηδηθεπκέλα ζέκαηα, 

φζνλ αθνξά ηε ρξήζε Visual Basic ζηελ εθαξκνγή AutoCAD. Τέινο παξνπζηάδνληαη 

ηα ζπκπεξάζκαηα θαη ζέκαηα γηα κειινληηθέο επεθηάζεηο.  
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Abstract 

The influence of technological development in education is an unquestionable reality 

that is aiming into a partial automation of tutoring and the facilitation of learning.    

 There has been developed, and is continuing to develop, a vast number of services 

and applications in order to be achieved the automation and the flexibility of the 

educational process. Multimedia self-teaching applications are an example of the 

above mentioned applications. They use the existing technologies, in order to offer a 

rich, attractive and flexible educational environment that encourages the enquiring, 

energetic and creative learning.  

 This thesis aims in the creation and presentation of a multimedia self-teaching 

application that covers the basic functions of the AutoCAD designing program. 

Initially, a brief overview of AutoCAD is presented, pointing the basic functions of 

this program. Secondly, a description of Camtasia program is provided, via which the 

capture of all the necessary videos has been accomplished. Afterwards, an overview of 

eXe software is presented, via which the unification and the production of the 

completed multimedia application is achieved. Additionally, certain special subjects, 

regarding the use of Visual Basic in AutoCAD, are reported. Finally, the conclusions 

and some future extensions are mentioned.  
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1 Ειζαγφγή 

Σθνπφο ηεο εξγαζίαο απηήο ήηαλ ε δεκηνπξγία Πνιπκεζηθνύ Δθπαηδεπηηθνύ Υιηθνύ 

Απηνδηδαζθαιίαο κε ηε βνήζεηα ησλ πξνγξακκάησλ eXe θαη Camtasia Studio 5 θαη σο 

πιηθφ πξνο παξνπζίαζε επηιέρζεθε ην ζρεδηαζηηθφ παθέην AutoCAD ηεο Autodesk. 

Ζ απηνδηδαζθαιία είλαη ε δηαδηθαζία εθκάζεζεο φπνπ ε εθπαίδεπζε ή 

αθξηβέζηεξα ε καζεζηαθή δηαδηθαζία εθηειείηαη κέζα απφ ηηο ζχγρξνλεο ηερλνινγίεο 

φπσο πξνγξάκκαηα ππνινγηζηψλ. Βαζηθφο ζθνπφο είλαη ν ζχγρξνλνο άλζξσπνο λα 

έρεη εμαζθαιηζκέλε ηε δπλαηφηεηα λα καζαίλεη κε πνιιαπινχο ηξφπνπο, λα έρεη 

επηινγέο ζην πσο θαη ηη ζα καζαίλεη θαη  λα απνηειεί ην «θέληξν ηεο καζεζηαθήο 

δηαδηθαζίαο». 

Τα ζεηηθά ζην ζέκα ηεο απηνδηδαζθαιίαο είλαη πξνθαλή. Τα εθπαηδεπηηθά κέζα 

(βηβιία, CD-ROMs, ήρνο, εηθφλεο, Video εθαξκνγέο Computer Based Training θηι.) 

είλαη ζηελ δηάζεζε ηνπ εθπαηδεπφκελνπ φπνηε θαη φπνπ εθείλνο ζέιεη. Τν πιηθφ 

απηνδηδαζθαιίαο είλαη πάληα δηαζέζηκν, νπφηε κπνξνχκε λα ην επαλαιακβάλνπκε 

παληνχ φπνπ θαη λα είκαζηε. Ο εθπαηδεπφκελνο κπνξεί λα απέρεη απφ ηνλ εθπαηδεπηή 

(ρψξνο, ρξφλνο ή θαη ηα δχν). Έηζη πξνζθέξεηαη ε δπλαηφηεηα νη ζπκκεηέρνληεο λα 

βξίζθνληαη ν θαζέλαο ζην δηθφ ηνπ ρψξν (γξαθείν, ζπίηη θηι.). Δπίζεο ππάξρεη πιήξεο 

ειεπζεξία απφ ην μεπεξαζκέλν κνληέιν ηεο “ζεηξηαθήο δηδαζθαιίαο”, δειαδή 

παξέρεηαη κάζεζε κε ηνλ ηξφπν πνπ ηαηξηάδεη ζηνλ θαζέλα. 

Τν κφλν αξλεηηθφ πνπ κπνξεί θάπνηνο λα πξνβάιιεη είλαη ε πζηέξεζε ζηε 

δπλαηφηεηα ζπλεξγαζίαο θαη αληαιιαγήο απφςεσλ κε ζπκκαζεηέο ή κε ηνλ 

εθπαηδεπηή, θάηη πνπ φκσο παξαθάκπηεηαη κε ηε βνήζεηα ηεο ζχγρξνλεο ηερλνινγίαο 

θαη ησλ κέζσλ ηεο φπσο e-mail, Video Conferencing, Instant Messaging, Forums θηι. 

Σηε ζπγθεθξηκέλε εξγαζία ινηπφλ εκθαλίδνληαη νη ηξφπνη θαη ηα κέζα 

απηνδηδαζθαιίαο ζηελ πξάμε. Πξνο εθκάζεζε παξνπζηάδεηαη ε εθαξκνγή AutoCAD 

ηεο Autodesk. Με ηηο εθαξκνγέο ηνπ Camtasia Studio 5 ζα δνχκε πψο ν δηδάζθσλ 

δεκηνπξγεί ζχγρξνλα ςεθηαθά εθπαηδεπηηθά κέζα κε εηθφλα θαη ήρν, ηα νπνία 

θαζνδεγνχλ ηνλ απηνδηδαζθφκελν ζε φιε ηε δηάξθεηα ηεο εθκάζεζεο ρξήζεο ηνπ 

πξνγξάκκαηνο. Με ηε ρξήζε ηνπ Camtasia Studio ν δεκηνπξγφο ηνπ εθπαηδεπηηθνχ 
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πιηθνχ κπνξεί λα θαηαζθεπάζεη βίληεν κε νπηηθέο αιιά θαη θσλεηηθέο νδεγίεο, πνπ ζα 

θαζνδεγνχλ ηνλ εθπαηδεπφκελν βήκα πξνο βήκα ζηελ επίηεπμε ηνπ επηζπκεηνχ 

απνηειέζκαηνο. Όηαλ ινηπφλ ζα έρεη δεκηνπξγεζεί ην εθπαηδεπηηθφ πιηθφ, ζα πξέπεη 

λα θηάζεη ζηνλ εθπαηδεπφκελν θαη κε ηνλ πην εχθνιν ηξφπν, ν νπνίνο πξνθαλψο είλαη 

ν Παγθφζκηνο Ηζηφο.  

Φηάλνπκε ινηπφλ ζηε ρξήζε ηνπ πξνγξάκκαηνο eXe, έλα πξφγξακκα αλνηρηνχ 

θψδηθα ην νπνίν βνεζάεη ζηε δεκηνπξγία ηζηνζειίδαο, ρσξίο λα είλαη απαξαίηεην ν 

εθπαηδεπηήο λα είλαη εηδήκσλ ζηε γλψζε θάπνηαο γιψζζαο φπσο HTML ή XML. Έηζη 

κπνξεί λα δεκηνπξγεζεί κηα ηζηνζειίδα ε νπνία ζα πεξηέρεη πνιπκέζα θαη πνιιέο 

άιιεο επθνιίεο ψζηε ην εθπαηδεπηηθφ πιηθφ λα θηάζεη ζηνλ εθπαηδεπφκελν ζε κηα 

κνξθή πνπ ζα ηνλ βνεζήζεη λα θαηαλνήζεη θαιχηεξα απηά πνπ ζέιεη ν δηδάζθσλ λα 

ηνπ κεηαδψζεη, φπσο γηα παξάδεηγκα ηε ρξήζε θάπνηνπ πξνγξάκκαηνο. Γηα εκάο -

φπσο ήδε αλαθέξζεθε- ζηηο επφκελεο ζειίδεο απηφ ην πξφγξακκα ζα είλαη ην 

ζρεδηαζηηθφ παθέην AutoCAD. 
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2 AutoCAD 

Τν AutoCAD είλαη ην πην δηαδεδνκέλν παγθνζκίσο ζρεδηαζηηθφ πξφγξακκα. 

Πξσηνεκθαλίζηεθε ζηηο αξρέο ηεο δεθαεηίαο ηνπ '80, ιίγν κεηά ηελ εκθάληζε ησλ 

πξψησλ πξνζσπηθψλ ππνινγηζηψλ, θαη ιεηηνπξγνχζε αξρηθά κέζσ ηνπ ιεηηνπξγηθνχ 

ζπζηήκαηνο MS-DOS. Σηηο αξρηθέο εθδφζεηο ήηαλ πνιχ δχζρξεζην πξφγξακκα θαη 

απαηηνχζε εμεηδηθεπκέλα άηνκα γηα ηε ρξήζε ηνπ. Απφ ηελ πξψηε θπθινθνξία ηνπ 

κέρξη ζήκεξα εκθαλίζηεθαλ αξθεηέο εθδφζεηο νη νπνίεο παξαηίζεληαη ζηελ Εικόνα 1.  

 

Δηθφλα 1: Ζ εμέιημε ηνπ ACAD 

 

Τν πεξηβάιινλ ηνπ AutoCAD αθνινπζεί κέρξη θαη ηελ έθδνζε 2009 ηε γεληθή 

εκθάληζε ησλ πεξηζζνηέξσλ παξαζπξηθψλ εθαξκνγψλ (Εικόνα 2) κε ηα ζεκαληη-

θφηεξα ζηνηρεία λα είλαη (ε αξίζκεζε είλαη ζε ζπκθσλία κε απηή ζηελ Εικόνα 2): 
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Δηθφλα 2: Τν πεξηβάιινλ εξγαζίαο ηνπ ACAD 2008
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 1 = βοηθήμαηα ζσεδίαζηρ 

 2 = ενηολέρ ζσεδίαζηρ 

 3 = ζύζηημα ζςνηεηαγμένων 

 4 = γπαμμή ενηολών 

 5 = γπαμμή καηάζηαζηρ 

 6 = γπαμμή επγαλείων 

 7 = μενού 

 8 = ενηολέρ επεξεπγαζίαρ 

 Ζ έθδνζε πνπ ρξεζηκνπνηήζεθε ζηελ παξνχζα εξγαζία είλαη ε 2008. Τν 

εθπαηδεπηηθφ πιηθφ πνπ αλαπηχρζεθε απεπζχλεηαη θχξηα ζε αξράξην ρξήζηε ρσξίο 

θαζφινπ εμνηθείσζε κε ηελ εθαξκνγή. Ο έκπεηξνο ρξήζηεο ζα βξεη αξθεηά ρξήζηκα 

ζηνηρεία θαζψο θαη ηερληθέο πνπ ρξεζηκνπνηνχλ έκπεηξνη ρξήζηεο δεδνκέλνπ φηη 

αμηνπνηήζεθαλ ρεηξφγξαθα θαη εκπεηξία δηδάζθνληα κε εθαηνληάδεο ψξεο δηδαθηηθήο 

εκπεηξίαο θαη απνδεδεηγκέλεο απνηειεζκαηηθφηεηαο ζηε κεηάδνζε γλψζεσλ.  

Απαιηήζειρ ζςζηήμαηορ για εγκαηάζηαζη 

Γηα λα κπνξεί θάπνηνο ρξήζηεο λα δνπιέςεη ην ζρεδηαζηηθφ πξφγξακκα AutoCAD ζα 

πξέπεη πξψηα λα θάλεη εγθαηάζηαζε ηνπ πξνγξάκκαηνο. Υπάξρνπλ δηάθνξεο 

απαηηήζεηο γηα λα νινθιεξσζεί ε εγθαηάζηαζε νη νπνίεο αλαθέξνληαη αλαιπηηθά 

παξαθάησ:  

2D Σχεδίαζη - 32bit AutoCAD 

 Intel Pentium IV, 2.2 GHz (πξνηεηλφκελν)  

 Microsoft Windows Vista Home Basic,Home Premium, Ultimate, Business, 

Enterprise Windows XP Home θαη Professional SP2, Windows 2000 SP4  

 512 MB RAM  

 750MB ειεχζεξα ζηνλ ζθιεξφ δίζθν γηα ηελ εγθαηάζηαζε  

 1024x768 VGA, True Color  

 Microsoft Internet Explorer 6.0 SP1 ή λεφηεξν  

2D Σχεδίαζη - 64bit AutoCAD  

 Τν 64-bit AutoCAD δελ κπνξεί λα εγθαηαζηαζεί ζε 32-bit Windows 

ιεηηνπξγηθά ζπζηήκαηα. Τα ππνζηεξηδφκελα ιεηηνπξγηθά ζπζηήκαηα γηα ην 
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64-bit AutoCAD είλαη ηα Windows XP Professional x64 Edition θαη ηα 

Windows Vista 64 bit.  

 AMD Athlon 64, AMD Opteron, Intel Xeon κε Intel EM64T, Intel Pentium 4 

κε Intel EM64T, είλαη νη ππνζηεξηδφκελνη επεμεξγαζηέο  

 1GB RAM  

 750MB ειεχζεξα ζηνλ ζθιεξφ δίζθν, γηα ηελ εγθαηάζηαζε  

3D Σχεδίαζη - 32bit & 64bit AutoCAD  

 Intel 3.0 GHz ή θαιχηεξνο επεμεξγαζηήο  

 Windows XP SP2  

 2GB RAM ή πεξηζζφηεξν  

 2GB ειεχζεξα ζηνλ ζθιεξφ δίζθν, ρσξίο ηελ εγθαηάζηαζε  

 1280x1024 , 32bit color video display adapter (True Color)  

 128MB ή πεξηζζφηεξν, OpenGL ή Direct3D θάξηα γξαθηθψλ (Δάλ ζαλ 

ιεηηνπξγηθφ ζχζηεκα ρξεζηκνπνηνχληαη ηα Windows Vista, απαηηείηαη 

Direct3D θάξηα γξαθηθψλ)  
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2.1 Πεπιβάλλον Δπγαζίαρ 

Αξρηθά γίλεηαη ε εθθίλεζε ηνπ πξνγξάκκαηνο είηε απφ θάπνηα ζπληφκεπζε ηνπ 

πξνγξάκκαηνο ζηελ επηθάλεηα εξγαζίαο είηε απφ ην κελνχ ηεο Έναρξης.  

Αθνχ αλνίμνπκε ην πξφγξακκα ζηελ αξρηθή νζφλε πξέπεη λα εληνπηζηνχλ ηα εμήο :  

 

Μελνύ = είλαη ε γξακκή κελνχ φπσο θαη ζε φια ηα πξνγξάκκαηα ησλ Windows ην 

νπνίν βξίζθεηαη ζην επάλσ κέξνο ηνπ παξαζχξνπ θάησ απφ ηελ κπάξα ηίηινπ.  

 

 

Γξακκή εξγαιείσλ = είλαη φιεο νη κπάξεο κε θνπκπηά εληνιψλ ηνπ AutoCAD. 

Υπάξρνπλ πνιιέο γξακκέο εληνιψλ, θάπνηεο απφ ηηο νπνίεο δελ θαίλνληαη φηαλ γίλεηαη 

εθθίλεζε ηνπ πξνγξάκκαηνο. Γηα λα εκθαλίζνπκε κηα γξακκή ε νπνία δελ θαίλεηαη 

επηιέγνπκε View -> Toolbars... Έλαο ελαιιαθηηθφο ηξφπνο γηα εκθάληζε ή απφθξπςε 

ησλ γξακκψλ εξγαιείσλ είλαη θάλνληαο δεμί θιηθ ζε θάπνην θνπκπί απφ θάπνηα 

γξακκή εξγαιείσλ πνπ θαίλεηαη, θαη ηφηε εκθαλίδεηαη έλα κελνχ κε ηα νλφκαηα φισλ 

ην γξακκψλ εξγαιείσλ. Δπηιέγνπκε κε έλα θιηθ ηηο γξακκέο πνπ ζέινπκε λα 

εκθαληζηνχλ θαη απνεπηιέγνπκε ηηο γξακκέο πνπ ζέινπκε λα απνθξχςνπκε. Οη 

γξακκέο εξγαιείσλ κπνξνχλ λα κεηαθεξζνχλ ζε νπνηνδήπνηε ζεκείν ηνπ παξαζχξνπ 

ηνπ AutoCAD κε ηελ ηερληθή drag and drop.  

 

 

Γξακκή εληνιώλ = είλαη ε πεξηνρή φπνπ δίλνληαη εληνιέο ζην πξφγξακκα 

γξάθνληάο ηεο ζην πιεθηξνιφγην. Ζ πεξηνρή απηή βξίζθεηαη ζην θάησ κέξνο ηνπ 

παξαζχξνπ ηνπ AutoCAD. Γηα λα εθηειεζηεί κηα εληνιή ηελ νπνία πιεθηξνινγήζακε 

ζηελ πεξηνρή απηή παηάκε ην θνπκπί Enter απφ ην πιεθηξνιφγην ή ην Space. Όηαλ 

εθηειείηαη κηα εληνιή κέζσ ηεο πεξηνρήο εληνιψλ κπνξεί λα εκθαλίδνληαη δηάθνξεο 

εξσηήζεηο νη νπνίεο δεηάλε λα πξνζδηνξηζηεί θάηη, ή αθφκα θαη έλα ζχλνιν απφ 

Δηθφλα 3 : Ζ γξακκή κελνχ 

Δηθφλα 4 : Γξακκή Δξγαιείσλ 
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επηινγέο. Οη επηινγέο εκθαλίδνληαη κέζα ζε ηεηξάγσλεο αγθχιεο θαη δηαρσξίδνληαη κε 

πιάγηεο θάζεηνπο /, θαζψο επίζεο θαη θάζε επηινγή έρεη έλα ή πεξηζζφηεξα θεθαιαία 

γξάκκαηα. Γηα λα επηιέμνπκε κηα απφ απηέο πιεθηξνινγνχκε ην/ηα γξάκκα/ηα θαη 

παηάκε ην Enter. Όηαλ παηάκε ην πιήθηξν Enter θαη δελ εθηειείηαη θάπνηα εληνιή, 

ηφηε εθηειείηαη ε ηειεπηαία εληνιή πνπ δφζεθε, δηφηη ην AutoCAD ζπκάηαη φιεο ηηο 

εληνιέο πνπ έρνπλ δνζεί απφ ηελ αξρή ηνπ ζρεδίνπ.  

 Γηα λα αθπξσζεί θάπνηα εληνιή παηάκε U ζηελ πεξηνρή εληνιψλ ή επηιέγνπκε 

Edit -> Undo. Ζ αθχξσζε γίλεηαη μεθηλψληαο απφ ηελ ηειεπηαία πξνο ηελ πξψηε 

εληνιή. Δπίζεο κπνξεί λα επαλεθηειεζηεί θάπνηα εληνιή πνπ αθπξψζεθε επηιέγνληαο 

Edit -> Redo. Πνιιέο εληνιέο έρνπλ εζσηεξηθφ Undo π.ρ φηαλ εθηειείηαη ε εληνιή 

line θαη αθνχ δψζνπκε ην πξψην ζεκείν κεηά εκθαλίδεη ηελ εξψηεζε Specify next 

point or [Undo]. Δπίζεο ππάξρεη θαη ην πιήθηξν Esc ην νπνίν αλ παηήζνπκε πξνθαιεί 

ηεξκαηηζκφ ηεο εληνιήο.  

 

 

Πεξηνρή ζρεδίαζεο = είλαη ε καχξε πεξηνρή ζην θέληξν ηνπ παξαζχξνπ ηνπ 

AutoCAD ζηελ νπνία γίλεηαη ε ζρεδίαζε. Με ηελ κεηαθίλεζε ηνπ πνληηθηνχ κέζα 

ζηελ πεξηνρή ζρεδίαζεο εκθαλίδεηαη έλαο ζηαπξφο (ζηαπξόλεκα) κε έλα κηθξφ 

ηεηξάγσλν (ηεηξάγσλν επηινγήο), ην νπνίν ρξεζηκνπνηείηαη γηα ηελ επηινγή 

αληηθεηκέλσλ. Σηελ θάησ αξηζηεξή κεξηά ηεο πεξηνρήο ζρεδίαζεο ππάξρεη ην ζχζηεκα 

ζπληεηαγκέλσλ (άμνλεο Φ,Υ).  

Δηθφλα 5 : Γξακκή εληνιψλ 
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Δηθφλα 6 : Πεξηνρή ζρεδίαζεο 

 

Γξακκή Καηάζηαζεο = είλαη ε γξακκή πνπ βξίζθεηαη θάησ απφ ηελ πεξηνρή 

εληνιψλ, ζηελ νπνία εκθαλίδνληαη πιεξνθνξίεο ζρεηηθέο κε ηελ ζρεδίαζε 

(ζπληεηαγκέλεο ηεο ηξέρνπζαο ζέζεο ηνπ ζηαπξνλήκαηνο, ηα εηθνλίδηα γηα ηελ 

γξήγνξε πξφζβαζε ζε ζπρλά ρξεζηκνπνηνχκελα ζηνηρεία - Status Bar Tray, ην 

εηθνλίδην δηαρείξηζεο εμσηεξηθψλ αλαθνξψλ - Manage Xrefs θ.η.ι.)  

Ζ ελεξγνπνίεζε θαη απελεξγνπνίεζε ησλ εληνιψλ γίλεηαη κε δεμί θιηθ ζε 

νπνηνδήπνηε κελνχ.  

Δπεηδή νη εληνιέο είλαη πνιιέο, γηα λα κελ ππάξρνπλ φιεο ε κηα πάλσ ζηελ άιιε 

ζηελ νζφλε, αξρηθά επηιέγνπκε ηηο εμήο: Draw, Modify, Object Properties,Standard 

Toolbar  

 

Δηθφλα 7 : Γξακκή θαηάζηαζεο  
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2.2 Γιασείπιζη Υώπος ΢σεδίαζηρ 

Τν AutoCAD παξέρεη ηελ δπλαηφηεηα ζηνπο ρξήζηεο ηνπ λα δηαρεηξίδνληαη ηελ νζφλε 

είηε κεγεζχλνληαο ή ζκηθξχλνληαο θάπνηα πεξηνρή ηνπ ζρεδίνπ γηα λα θαίλνληαη 

πεξηζζφηεξεο ιεπηνκέξεηεο (Zoom ), είηε θπιψληαο κε ηελ βνήζεηα ηνπ πνληηθηνχ πξνο 

δηαθνξεηηθέο θαηεπζχλζεηο ηεο νξαηήο πεξηνρήο ηνπ ζρεδίνπ (Pan).  

Οη παξαθάησ επηινγέο ππάξρνπλ ζην Menu->View->Zoom θαη Menu->View->Pan 

αληίζηνηρα. 

 

Υπάξρνπλ θαη αληίζηνηρα θνπκπηά ζηελ γξακκή εξγαιείσλ πνπ ζρεηίδνληαη κε ηηο 

δχν παξαπάλσ ιεηηνπξγίεο. 

 

Δηθφλα 9 : Τα θνπκπηά Zoom θαη Pan ζηε γξακκή εξγαιείσλ 

 

Οη δχν απηέο επηινγέο δελ αιιάδνπλ ηελ ζέζε ησλ αληηθεηκέλσλ αιιά κφλν ηνλ 

ηξφπν κε ηνλ νπνίν θαίλνληαη ηα αληηθείκελα ηνπ ζρεδίνπ.  

2.2.1 Zoom 

Υπάξρνπλ δηάθνξεο παξαιιαγέο ηεο εληνιήο Zoom. Παξαθάησ αλαιχεηαη ε θάζε κία 

μερσξηζηά:  

 

Δηθφλα 8 : Δπηινγέο Zoom θαη Pan 
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 Zoom Window = δεηάεη δχν ζεκεία ηα νπνία νξίδνπλ κηα νξζνγψληα 

πεξηνρή νη δηαζηάζεηο ηεο νπνίαο κεηά ηελ νινθιήξσζε ηεο εληνιήο αληηζηνηρνχλ ζηηο 

δηαζηάζεηο ηεο πεξηνρήο ζρεδίαζεο.  

 Zoom Dynamic = εκθαλίδεη νιφθιεξν ην ζρέδην ζε ζκίθξπλζε ζηελ 

πεξηνρή ζρεδίαζεο. Ταπηφρξνλα εκθαλίδεη θαη ηξία πιαίζηα. Τν έλα πιαίζην είλαη 

αθίλεην κε δηαθεθνκκέλε κπιε γξακκή θαη δειψλεη ηα φξηα ηνπ ζρεδίνπ. Τν άιιν 

ζρέδην είλαη αθίλεην κε δηαθεθνκκέλε πξάζηλε γξακκή θαη δειψλεη ηελ ηξέρνπζα 

άπνςε ηνπ ζρεδίνπ. Τν ηξίην πιαίζην είλαη θηλνχκελν θαη κε κεηαβιεηφ κέγεζνο. Δάλ 

παηήζνπκε Enter ηφηε ην ηκήκα ηνπ ζρεδίνπ πνπ βξηζθφηαλ εληφο ηνπ θηλνχκελνπ 

πιαηζίνπ θαηαιακβάλεη νιφθιεξε ηελ πεξηνρή ζρεδίαζεο.  

 Zoom Scale = φηαλ επηιεγεί, ε επηινγή απηή δεηάεη λα δνζεί έλαο 

αξηζκφο. Δάλ ν αξηζκφο είλαη θπζηθφο θαη κεγαιχηεξνο ηεο κνλάδαο, κεγεζχλεη ζε 

ζρέζε κε ηα φξηα ηνπ ζρεδίνπ ηφζεο θνξέο φζεο δειψλεη ν αξηζκφο πνπ δφζεθε. Δάλ ν 

αξηζκφο πνπ ζα δνζεί είλαη κηθξφηεξνο ηεο κνλάδαο ηφηε ζκηθξχλεη ζε ζρέζε κε ηα 

φξηα ηνπ ζρεδίνπ ηφζεο θνξέο φζεο δειψλεη θαη ν αξηζκφο απηφο.  

 Zoom Center = δεηάεη λα δνζεί έλα ζεκείν ην νπνίν ζα ηνπνζεηεζεί 

ζην θέληξν ηεο νζφλεο, θαη έλα χςνο, ε ηηκή ηνπ νπνίνπ ζα θαζνξίζεη ην χςνο απφ ην 

νπνίν ζα θαίλεηαη ην ζρέδην κεηά ηελ εθηέιεζε ηεο εληνιήο απηήο. 

 Zoom In = δηπιαζηάδεη ηε κεγέζπλζε.  

 Zoom Out = ππνδηπιαζηάδεη ηελ κεγέζπλζε.  

 Zoom All = θάλεη Zoom ηα φξηα ηνπ ζρεδίνπ, ζπκπεξηιακβάλνληαο 

κέζα θαη φζα αληηθείκελα βξίζθνληαη έμσ απφ ηα φξηα.  

 Zoom Extents = θάλεη Zoom κφλν ηελ πεξηνρή ηνπ ζρεδίνπ ζηελ νπνία 

ππάξρνπλ ζρεδηαζκέλα αληηθείκελα. 
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 Zoom Previous = επαλαθέξεη ηελ πξνεγνχκελε άπνςε ηνπ ζρεδίνπ.  

 

2.2.2 Pan 

Όπσο γηα ηελ εληνιή Zoom έηζη θαη γηα ηελ εληνιή Pan ππάξρνπλ δηάθνξεο πξνηξνπέο 

νη νπνίεο αλαθέξνληαη παξαθάησ:  

 

 Pan RealTime = παηψληαο αξηζηεξφ θιηθ πάλσ ζηελ πεξηνρή ζρεδίαζεο 

θαη θξαηψληαο ην παηεκέλν κεηαθηλείηαη ην ζρέδην ζχκθσλα κε ηηο θηλήζεηο ηνπ 

πνληηθηνχ.  

 Pan Point = δεηάεη λα δνζνχλ δπν ζεκεία ηα νπνία ζρεκαηίδνπλ έλα 

δηάλπζκα πνπ ζα θαζνξίδεη ηελ θαηεχζπλζε πξνο ηελ νπνία ζα θπιήζεη ην ζρέδην.  

   Pan Left/Right/Up/Down = ην ζρέδην θπιάεη πξνο 

ηελ αληίζηνηρε θαηεχζπλζε, αξηζηεξά/δεμηά/πάλσ/θάησ αληίζηνηρα. 

 

2.2.3 Δπιλογή Ανηικειμένων ΢σεδίαζηρ 

Ζ δηαδηθαζία επηινγήο ησλ αληηθεηκέλσλ είλαη πνιχ ζπρλή ζην AutoCAD. Όηαλ πξέπεη 

λα γίλεη κνξθνπνίεζε θάπνηνπ ζρεδηαζκέλνπ αληηθεηκέλνπ, αξρηθά πξέπεη λα 

επηιέμνπκε ην ζπγθεθξηκέλν αληηθείκελν θαη χζηεξα λα γίλεη ε κνξθνπνίεζε ηνπ.  

Δπίζεο φηαλ ελεξγνπνηνχκε θάπνηεο απφ ηηο εληνιέο επεμεξγαζίαο φπσο move, 

copy, erase θ.η.ι.  

 

Δηθφλα 10 : Δξγαιεηνζήθε Μνξθνπνίεζεο 

ηφηε ζηελ γξακκή εληνιψλ εκθαλίδεηαη ε εξψηεζε Select Objects (Δπέιεμε ηα 

αληηθείκελα).  
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Δηθφλα 11 : Δξψηεζε Select Objects 

 

Υπάξρνπλ δηάθνξνη ηξφπνη γηα λα επηιέμνπκε θάπνην αληηθείκελν. Έλαο απιφο 

ηξφπνο είλαη κε θιηθ πάλσ ζην αληηθείκελν. Έλαο δεχηεξνο ηξφπνο είλαη θάλνληαο θιηθ 

ζε θάπνην ζεκείν ηεο πεξηνρήο ζρεδίαζεο πνπ δελ ππάξρεη θάπνην αληηθείκελν θαη 

κεηαθηλψληαο ην πνληίθη δεμηά ή αξηζηεξά.  

Σηελ πεξίπησζε πνπ ην πνληίθη κεηαθηλείηαη δεμηά απφ ην αξρηθφ ζεκείν (ην 

ζεκείν ζην νπνίν θάλακε θιηθ) ζρεκαηίδεηαη έλα νξζνγψλην κε ζπλερή γξακκή. 

Κάλνληαο έλα δεχηεξν θιηθ ην νξζνγψλην εμαθαλίδεηαη θαη θαίλεηαη πσο επηιέρζεθαλ 

κφλν ηα αληηθείκελα πνπ βξίζθνληαλ νιφθιεξα κέζα ζην νξζνγψλην.  

 

Δηθφλα 12 : Δπηινγή αληηθεηκέλσλ (απφ αξηζηεξά πξνο ηα δεμηά) 

 

Σηελ πεξίπησζε πνπ ην πνληίθη κεηαθηλείηαη αξηζηεξά απφ ην αξρηθφ ζεκείν (ην 

ζεκείν ζην νπνίν θάλακε θιηθ) ζρεκαηίδεηαη έλα νξζνγψλην κε δηαθεθνκκέλε γξακκή. 

Κάλνληαο έλα δεχηεξν θιηθ ην νξζνγψλην εμαθαλίδεηαη θαη θαίλεηαη πσο επηιέρζεθαλ 

ηα αληηθείκελα πνπ βξίζθνληαλ είηε νιφθιεξα κέζα ζην νξζνγψλην είηε ηέκλνληαλ 

απφ ην νξζνγψλην.  
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Δηθφλα 13 : Δπηινγή αληηθεηκέλσλ (απφ δεμηά πξνο ηα αξηζηεξά) 

 

Υπάξρνπλ θαη άιιεο πξνηξνπέο γηα ηελ επηινγή αληηθεηκέλσλ νη νπνίεο δελ 

θαίλνληαη άκεζα. Σπγθεθξηκέλα φηαλ ελεξγνπνηείηαη θάπνηα εληνιή επεμεξγαζίαο θαη 

εκθαληζηεί ζηελ γξακκή εληνιψλ ε εξψηεζε Select Object (Δπέιεμε ην αληηθείκελν), 

ηφηε πιεθηξνινγψληαο ζηελ γξακκή εληνιψλ ηελ ιέμε Previous θαη παηψληαο Enter 

επηιέγεηαη απηφκαηα ην αληηθείκελν πνπ είρε επηιεγεί πξνεγνπκέλσο.  

Πιεθηξνινγψληαο ηελ ιέμε Last θαη παηψληαο Enter επηιέγεηαη απηφκαηα ην 

ηειεπηαίν αληηθείκελν πνπ ζρεδηάζηεθε.  

Πιεθηξνινγψληαο ηελ ιέμε All θαη παηψληαο Enter επηιέγνληαη απηφκαηα φια ηα 

αληηθείκελα ηνπ ζρεδίνπ.  

Υπάξρνπλ θαη άιιεο πξνηξνπέο γηα επηινγή αληηθεηκέλσλ νη νπνίεο εκθαλίδνληαη 

φηαλ πιεθηξνινγείηαη ζηελ γξακκή εληνιψλ ε θξάζε Select Objects. 

 

Δηθφλα 14 : Δπηινγή αληηθεηκέλσλ απφ γξακκή εληνιψλ 
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2.3 ΢ςζηήμαηα ΢ςνηεηαγμένων 

Κάζε ηη πνπ ζρεδηάδεηαη ζην AutoCAD είλαη πξνζδηνξηζκέλν κε αθξίβεηα. Γειαδή, 

θάζε γεσκεηξηθφ ζρήκα πξνζδηνξίδεηαη απφ έλα ζχλνιν ζεκείσλ, ηα νπνία 

ηνπνζεηνχληαη ζηελ πεξηνρή ζρεδίαζεο κε βάζε έλα απιφ ζχζηεκα ζπληεηαγκέλσλ ην 

νπνίν απνηειείηαη απφ δχν άμνλεο, ηνλ άμνλα Φ θαη ηνλ άμνλα Υ, νη νπνίνη ηέκλνληαη 

θάζεηα, δεκηνπξγψληαο έηζη ηελ αξρή ησλ αμφλσλ Ο (0,0), θαζψο επίζεο θαη ηέζζεξηο 

πεξηνρέο ζρεδίαζεο.  

 

Δηθφλα 15: Σχζηεκα Σπληεηαγκέλσλ 

 

Σην AutoCAD ππάξρνπλ ηξεηο ηχπνη ζπληεηαγκέλσλ ζην ρψξν ηξηψλ δηαζηάζεσλ 

(θαξηεζηαλέο, ζθαηξηθέο, θπιηλδξηθέο ) θαη δχν ηχπνη ζπληεηαγκέλσλ ζην ρψξν δπν 

δηαζηάζεσλ ( θαξηεζηαλέο θαη πνιηθέο ).  

Οη θαξηεζηαλέο ζπληεηαγκέλεο ελφο ζεκείνπ ρσξίδνληαη κε θόκκα (,) : Γx,Γy,Γz  

Όηαλ ππάξρεη κφλν ην Γx,Γy ηφηε ζεκαίλεη πσο ε ζπληεηαγκέλε Ε έρεη ηηκή 0.  

Γηα ηνλ πξνζδηνξηζκφ ησλ ζθαηξηθψλ ζπληεηαγκέλσλ ελφο ζεκείνπ Α, δειψλεηαη 

ε απφζηαζε ρ ηνπ ζεκείνπ απφ ηελ αξρή ησλ αμφλσλ Ο, ε γσλία θ ηεο πξνβνιήο ηνπ 

ζεκείνπ ζην επίπεδν Oxy κε ηνλ άμνλα Ox, ε γσλία φ πνπ ζρεκαηίδεη ην OA κε ην 

επίπεδν Oxy. Οη ηξεηο απηνί αξηζκνί ζηηο ζθαηξηθέο ζπληεηαγκέλεο δειψλνληαη σο 

εμήο : ξ<ζ<θ  
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Όζνλ αθνξά ηνλ πξνζδηνξηζκφ ησλ θπιηλδξηθψλ ζπληεηαγκέλσλ ελφο ζεκείνπ Α, 

δειψλεηαη ε απφζηαζε ξz ηνπ ζεκείνπ απφ ηνλ άμνλα Z, ε γσλία ζ ηεο πξνβνιήο ηνπ 

ζεκείνπ ζην επίπεδν Oxy κε ηνλ άμνλα Ox, ε αλχςσζε ηνπ ζεκείνπ Γz απφ ην επίπεδν 

Oxy. Οη θπιηλδξηθέο ζπληεηαγκέλεο δειψλνληαη σο εμήο : ξz <ζ,Γz  

Σε πεξίπησζε πνπ ε γσλία θ απφ ηηο ζθαηξηθέο ζπληεηαγκέλεο θαη ε αλχςσζε Γz 

απφ ηηο θπιηλδξηθέο ζπληεηαγκέλεο παξαιείπνληαη, ηφηε ηα δπν απηά είδε ζπζηήκαηα 

ζπληεηαγκέλσλ κεηαηξέπνληαη ζε πνιηθέο ζπληεηαγκέλεο. Οη ηέζζεξηο βαζηθέο 

δηεπζχλζεηο ησλ πνιηθψλ ζπληεηαγκέλσλ είλαη δεμηά 0, πάλσ 90, αξηζηεξά 180 θαη 

θάησ 270 ή –90. 

2.3.1 Δίδη ΢ςνηεηαγμένων 

Τα γεσκεηξηθά αληηθείκελα πξνζδηνξίδνληαη απφ έλα ζχλνιν ζεκείσλ. Ο θαζνξηζκφο 

ησλ ζπληεηαγκέλσλ ησλ ζεκείσλ απηψλ κπνξεί λα γίλεη κε δχν ηξφπνπο: κε ηνλ 

απφιπην θαη ηνλ ζρεηηθφ. Καη νη δχν ηξφπνη είλαη κεηαμχ ηνπο ηζφηηκνη, δειαδή ην 

απνηέιεζκα ηεο πεξηγξαθήο ηεο ζέζεο ησλ ζεκείσλ ζα είλαη ην ίδην, αλεμάξηεηα απφ 

ην πνηφο ηξφπνο ζα ρξεζηκνπνηεζεί.  

Με ηνλ απφιπην ηξφπν, νη ζπληεηαγκέλεο θάζε ζεκείνπ δίλνληαη ζε ζρέζε κε ηελ 

αξρή ησλ αμφλσλ, (π.ρ. (-5,3) ). Με ηνλ ηξφπν απηφ, θάζε ζεκείν είλαη δηαθνξεηηθή 

νληφηεηα θαη ε πεξηγξαθή ηνπ δελ ζρεηίδεηαη κε θαλέλα άιιν ζεκείν, εθηφο απφ ην 

κεδεληθφ (ηελ αξρή ηνπ ζπζηήκαηνο ζπληεηαγκέλσλ).  

Με ην ζρεηηθφ ηξφπν νη ζπληεηαγκέλεο θάζε ζεκείνπ νξίδνληαη αλαθνξηθά κε ηε 

ζέζε ηνπ πξνεγνχκελνπ ζεκείνπ. Γηα λα δεισζεί ε αλαθνξά ζην πξνεγνχκελν ζεκείν 

ρξεζηκνπνηείηαη ην ζχκβνιν @ (π.ρ. (@0,2) ).  

 

Λπκέλε άζθεζε : 

Σρεδίαζε Τεηξαγψλνπ κε ηελ ρξήζε ησλ ζρεηηθψλ ζπληεηαγκέλσλ.  

Έζησ νη ζπληεηαγκέλεο ησλ ζεκείσλ A=200,200 B=300,200 C=300,300 D=200,300  
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Δηθφλα 16: Σρεδίαζε Τεηξαγψλνπ 

 

Γίλεηαη πξψηα ην ζεκείν Α σο 200,200  

A: 200,200 

  

Τν ζεκείν Β κπνξεί λα ην δνζεί είηε ζε ζρέζε κε ηελ αξρή ησλ αμφλσλ (300,200) είηε 

ζε ζρέζε κε ην πξνεγνχκελν ηνπ ζεκείν (Α) (@100,0) (παπάκι) πνπ ζεκαίλεη πσο 

απμάλεηαη θαηά ζηνλ άμνλα Φ θαηά 100 κνλάδεο θαη ε ηηκή ηνπ Υ δελ αιιάδεη, είηε ε 

ηηκή ηνπ Φ απμάλεηαη θαηά 100 κνλάδεο κε θαηεχζπλζε δεμηά.  

B: 300,200  

@100,0  

@100<0  
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Γίλεηαη ην ζεκείν C ζε ζρέζε κε ηελ αξρή ησλ αμφλσλ (300,300), είηε ζε ζρέζε κε ην 

ζεκείν B (@0,100) πνπ ζεκαίλεη πσο απμάλεηαη ην Y θαηά 100 κνλάδεο θαη ε ηηκή 

ηνπ X δελ αιιάδεη, είηε ε ηηκή ηνπ Υ απμάλεηαη θαηά 100 κνλάδεο κε θαηεχζπλζε 

πξνο ηα πάλσ.  

C: 300,300  

@0,100  

@100<90  

 

Γίλεηαη ην D ζε ζρέζε κε ηελ αξρή ησλ αμφλσλ (200,300), είηε ζε ζρέζε κε ην ζεκείν 

C (@-100,0) πνπ ζεκαίλεη πσο κεηψλεηαη ε ηηκή ηνπ Φ θαηά 100 κνλάδεο, είηε ε ηηκή 

ηνπ Φ κεηψλεηαη 100 κνλάδεο κε θαηεχζπλζε πξνο ηα αξηζηεξά.  

D: 200,300  

@-100,0  

@100<180  

 

Γίλεηαη ην Α ζε ζρέζε κε ηελ αξρή ησλ αμφλσλ (200,200), είηε ζε ζρέζε κε ην ζεκείν 

D (@0,-100) πνπ ζεκαίλεη πσο κεηψλεηαη ε ηηκή ηνπ Y 100 κνλάδεο, είηε ε ηηκή ηνπ Υ 

κεηψλεηαη θαηά 100 κνλάδεο κε θαηεχζπλζε πξνο ηα θάησ.  

Α: 200,200  

@0,-100  

@100<270  

@100<-90 

2.3.2 Μοπθέρ Δμθάνιζηρ ΢σεδιαζηικών Μονάδων 

Μέρξη ζηηγκήο αλαθέξζεθαλ αξηζκνί πνπ εθθξάδνπλ κήθε θαη γσλίεο ρσξίο λα 

αλαθεξζεί θάπνηα κνλάδα κέηξεζεο.  

 

Σην AutoCAD δελ ππάξρνπλ κνλάδεο κέηξεζεο, νη απνζηάζεηο κεηξηνχληαη ζε 

Σρεδηαζηηθέο Μνλάδεο (Drawing Units), θαη δελ έρεη ζεκαζία ζε ηη αληηζηνηρεί κηα 

ΣΜ. Ζ αληηζηνίρεζε κηαο ΣΜ γίλεηαη ζχκθσλα κε ηνπο ηχπνπο εκθάληζεο ησλ 

απνζηάζεσλ.  
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Υπάξρνπλ πέληε δηαθνξεηηθνί ηξφπνη εκθάληζεο ησλ απνζηάζεσλ ζην AutoCAD. 

Δπηιέγνληαο Format->Units εκθαλίδεηαη ην πιαίζην Drawing Units θαη ζην Length-

Type θαζνξίδεηαη ν ηχπνο ησλ απνζηάζεσλ.  

 Δπηζηεκνληθφο (Scientific)  

 Γεθαδηθφο (Decimal)  

 Τερληθφο (Engineering)  

 Αξρηηεθηνληθφο (Architectural)  

 Κιαζκαηηθφο (Fractional)  

 Καη γηα ηηο γσλίεο ππάξρνπλ πέληε δηαθνξεηηθνί ηξφπνη εκθάληζεο.  

 Γεθαδηθέο κνίξεο (Decimal Degrees)  

 Μνίξεο/πξψηα/δεχηεξα (Deg/min/sec)  

 Βαζκνί (Grads)  

 Αθηίληα Radians)  

 Τνπνγξαθηθέο κνλάδεο (Surveyor's Units)  

 

Δπηιέγνληαο Format->Units εκθαλίδεηαη ην πιαίζην Drawing Units θαη ζην Angle-

Type θαζνξίδεηαη ν ηχπνο ηεο γσλίαο.  

Θεηηθή θνξά κέηξεζεο ησλ γσληψλ είλαη ε αληίζεηε ηεο θνξάο πεξηζηξνθήο ησλ 

δεηθηψλ ηνπ ξνινγηνχ. Σε πεξίπησζε πνπ είλαη επηιεγκέλν ην Clockwise ζην πιαίζην 

Drawing Units ηφηε ζεηηθή θνξά ησλ γσληψλ είλαη ε θνξά πεξηζηξνθήο ησλ δεηθηψλ 

ηνπ ξνινγηνχ.  

Δπίζεο παηψληαο ην θνπκπί Direction ηνπ πιαηζίνπ Drawing Units εκθαλίδεηαη ην 

πιαίζην Direction Control ζην νπνίν θαζνξίδεηαη ε θαηεχζπλζε πνπ αληηζηνηρεί ζηηο 0 

κνίξεο. 

2.3.3 Γιασείπιζη Απσείων 

Γηα λα επαλαρξεζηκνπνηεζνχλ ή λα κνξθνπνηεζνχλ ηα ζρέδηα ζην AutoCAD πξέπεη λα 

ππάξρνπλ απνζεθεπκέλα θάπνπ. Ζ δηαρείξηζε ησλ ζρεδίσλ ζην AutoCAD φπσο θαη ζε 

φια ηα άιια πξνγξάκκαηα ησλ Windows γίλεηαη κε ηηο επηινγέο πνπ βξίζθνληαη ζην 

κελνχ File...(New, Open, Close, Save, Save As, Export).  
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Δηθφλα 17 : Δπηινγέο ηνπ Μελνχ File 

 

Γηα θάπνηεο απφ ηηο επηινγέο ππάξρνπλ θαη θνπκπηά ζηελ γξακκή εξγαιείσλ standard 

toolbar. 

 

Δηθφλα 18 : Γξακκή εξγαιείσλ standard toolbar 

 

Όια ηα αξρεία πνπ δεκηνπξγνχληαη ζην AutoCAD έρνπλ επέθηαζε .dwg απφ ηελ ιέμε 

drawing (ζρέδην).  

Παξαθάησ εμεγνχληαη αλαιπηηθά νη ιεηηνπξγίεο ησλ εληνιψλ δηαρείξηζεο:  

 

New  -> ρξεζηκνπνηείηαη γηα ηελ δεκηνπξγία λένπ ζρεδίνπ.  

Open -> ρξεζηκνπνηείηαη γηα λα αλνίμεη έλα ππάξρνλ ζρέδην ην νπνίν είλαη 

απνζεθεπκέλν θάπνπ ζηνλ δίζθν ή ζε θάπνηα απνζεθεπηηθή ζπζθεπή.  

Close -> θιείλεη ην ηξέρνλ ζρέδην (κπνξνχλ λα ππάξρνπλ παξαπάλσ απφ έλα ζρέδην 

αλνηθηά). Σε πεξίπησζε πνπ επηιέγνπκε ηελ εληνιή απηή ελψ έρεη γίλεη αιιαγή ζην 

ζρέδην ρσξίο λα έρεη απνζεθεπηεί, ηφηε εκθαλίδεηαη έλα πξνεηδνπνηεηηθφ πιαίζην 

δηαιφγνπ πνπ δεηάεη απνζήθεπζε ησλ αιιαγψλ, αθχξσζε ηεο εληνιήο close ή έμνδνο, 

δειαδή θιείζηκν ηνπ ζρεδίνπ ρσξίο λα απνζεθεπηνχλ νη αιιαγέο.  
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Save as -> απνζεθεχεη θάπνην αξρείν αθνχ πξψηα δεηεζεί ην φλνκα ηνπ αξρείνπ θαη ε 

δηαδξνκή ζηελ νπνία ζα γίλεη ε απνζήθεπζε.  

Save -> απνζεθεχεη ηηο αιιαγέο ελφο ήδε απνζεθεπκέλνπ ζρεδίνπ ή φπσο θαη ε 

εληνιή Save As, εκθαλίδεη έλα πιαίζην πνπ δεηάεη ην φλνκα ηνπ ζρεδίνπ θαη ηελ 

δηαδξνκή πνπ ζα απνζεθεπηεί, ζε πεξίπησζε πνπ ην ζρέδην δελ είλαη απνζεθεπκέλν.  

Export -> απνζεθεχεη θάπνην ζρέδην ζε κνξθή αξρείνπ ην νπνίν είλαη αλαγλσξίζηκν 

απφ άιια πξνγξάκκαηα. Κάπνηεο απφ ηηο κνξθέο πνπ ππνζηεξίδεη ε επηινγή Export 

είλαη : WMF, eps, bmp θ.η.ι. 
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2.4 Βοηθήμαηα ΢σεδίαζηρ 

Γηα πην γξήγνξε θαη αθξηβή ζρεδίαζε είλαη απαξαίηεηε ε ρξήζε ησλ βνεζεκάησλ 

ζρεδίαζεο ηα νπνία κπνξεί λα ελεξγνπνηεζνχλ ή λα απελεξγνπνηεζνχλ επηιέγνληαο 

On ή Off κε δεμί θιηθ πάλσ ζην αληίζηνηρν εηθνλίδην πνπ βξίζθεηαη ζηελ γξακκή 

θαηάζηαζεο. 

 

 

Δηθφλα 19 : Βνεζήκαηα ζρεδίαζεο OSNAP 

 

 

Δηθφλα 20 : Δλεξγνπνίεζε – απελεξγνπνίεζε OSNAP  

 

είηε θάλνληαο δεμί θιηθ ζε νπνηνδήπνηε θνπκπί θάπνηαο γξακκήο εξγαιείσλ φπσο 

θαίλεηαη παξαθάησ :  
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Δηθφλα 21 : Δλεξγνπνίεζε OSNAP κέζσ γξακκήο εξγαιείσλ 

2.4.1 Osnap 

Τν βνήζεκα Osnap (Object Snap) δηεπθνιχλεη ηελ δηαδηθαζία επηινγήο ελφο ζεκείνπ 

θάπνηνπ αληηθεηκέλνπ εθφζνλ ην ζεκείν πξνο επηινγή είλαη ραξαθηεξηζηηθφ ζεκείν 

ηνπ αληηθεηκέλνπ απηνχ.  

Οη ιεηηνπξγίεο Osnap ελεξγνπνηνχληαη παηψληαο ηα αληίζηνηρα θνπκπηά απφ ηελ 

γξακκή εξγαιείσλ Object Snap. 

 

Δηθφλα 22: Δξγαιεηνζήθε OSNAP 
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Όηαλ ελεξγνπνηνχκε θάπνηα εληνιή θαη ζηελ γξακκή εληνιψλ δεηείηαη λα δνζεί 

έλα ζεκείν, ηφηε επηιέγνπκε θάπνηα αληίζηνηρε ιεηηνπξγία Osnap θαη πιεζηάδνληαο 

κε ην πνληίθη ην αληηθείκελν, αθνχ εκθαληζηεί έλα ρξσκαηηζηφ ζχκβνιν ζηε ζέζε ηνπ 

ζεκείνπ πξνο επηινγή, κε έλα θιηθ επηιέγεηαη ην ζεκείν απηφ.  

Παξάδεηγκα :  

 Εεηείηαη κηα γξακκή ε νπνία ζα εθάπηεηαη ζε έλαλ θχθιν. Δλεξγνπνηνχκε ηελ 

εληνιή line, κεηά ηελ εξψηεζε Specify first point δίλνπκε ην πξψην ζεκείν είηε κε 

ζπληεηαγκέλεο είηε κε θιηθ ζηελ πεξηνρή ζρεδίαζεο. Δπηιέγνπκε ηελ ιεηηνπξγία Snap 

to Tangent απφ ηελ γξακκή εξγαιείσλ Object Snap θαη κεηαθηλνχκε ην πνληίθη πξνο 

ηνλ θχθιν κέρξη λα εκθαληζηεί ην ρξσκαηηζηφ ζχκβνιν ηεο εθαπηνκέλεο. Αθνχ 

εκθαληζηεί ην ζχκβνιν, κε έλα θιηθ επηιέγεηαη ην ζεκείν. 

 

Δηθφλα 23 : Δθαπηνκέλε (tangent) OSNAP 

 

Έλαο δεχηεξνο ηξφπνο γηα ηελ επηινγή ησλ ιεηηνπξγηψλ Osnap είλαη παηψληαο δεμί 

θιηθ θαη επηιέγνληαο Settings φπσο θαίλεηαη ζην παξαθάησ εηθνλίδην :  

 

Δηθφλα 24 : Δπηινγή ιεηηνπξγηψλ OSNAP 
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Αθνχ επηιέμνπκε ην Settings εκθαλίδεηαη ην παξαθάησ πιαίζην ζην νπνίν κε έλα 

θιηθ ελεξγνπνηείηαη θαη απελεξγνπνηείηαη ε θάζε ιεηηνπξγία Osnap.  

Παηψληαο ην θνπκπί Select All ζηα δεμηά ηνπ πιαηζίνπ επηιέγνληαη ηαπηφρξνλα 

φιεο νη ιεηηνπξγίεο Osnap, ελψ επηιέγνληαο ην θνπκπί Clear All απελεξγνπνηνχληαη 

ηαπηφρξνλα φιεο νη ιεηηνπξγίεο Osnap.  

 

Δηθφλα 25 : Λεηηνπξγίεο OSNAP 

 

 Όπσο θαίλεηαη θαη ζηελ παξαπάλσ εηθφλα, ππάξρνπλ δηάθνξεο επηινγέο Osnap. 

Κάπνηεο απφ απηέο είλαη:  

 

Endpoint = επηιέγεη ηα άθξα επζχγξακκσλ ηκεκάησλ 

Midpoint = επηιέγεη ην κέζν επζχγξακκσλ ηκεκάησλ  

Center = επηιέγεη ην θέληξν θακππινεηδψλ αληηθεηκέλσλ 

Nearest = επηιέγεη ην πιεζηέζηεξν ζεκείν νπνηνπδήπνηε αληηθεηκέλνπ  

Node = επηιέγεη έλα αληηθείκελν ζεκείνπ αλ ππάξρεη ζηελ πεξηνρή πνπ θάλνπκε θιηθ  
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Quadrant = επηιέγεη ην πιεζηέζηεξν ηεηαξηεκφξην ηνπ θχθινπ ή ηνπ ηφμνπ  

Intersection = επηιέγεη ην ζεκείν ηνκήο δχν γξακκψλ  

Extension = επηηξέπεη ηελ επηινγή ελφο ζεκείνπ ζηελ πξνέθηαζε κηαο ππάξρνπζαο 

γξακκήο  

Insertion = επηιέγεη ην ζεκείν εηζαγσγήο ελφο αληηθεηκέλνπ 

Perpendicular = επηιέγεη ην ζεκείν ζην νπνίν θέξεηαη ε θάζεηνο κεηαμχ δχν 

αληηθεηκέλσλ  

Tangent = εληνπίδεη ζεκεία αληηθεηκέλσλ ζηα νπνία ηα ππφ ζρεδίαζε αληηθείκελα 

κπνξνχλ λα εθάπηνληαη  

Parallel = επηιέγεη ζεκεία ηα νπνία ζρεκαηίδνπλ παξάιιειε γξακκή πξνο θάπνηα 

ππάξρνπζα  

2.4.2 Ortho-Polar 

Με ηελ βνήζεηα ηνπ πιήθηξνπ Ortho ελεξγνπνηείηαη θαη απελεξγνπνηείηαη ε 

ιεηηνπξγία νξζνγψληαο ζρεδίαζεο. Όηαλ είλαη ελεξγνπνηεκέλν ην Ortho ην πνληίθη 

θηλείηαη ππνρξεσηηθά ζε νξηδφληηα θαη θαηαθφξπθε δηεχζπλζε.  

Σηελ εηζαγσγή ζεκείσλ ην Ortho δηεπθνιχλεη ηνλ ηξφπν ζρεδίαζεο. Αληί λα 

δνζνχλ ζπληεηαγκέλεο γηα ην θάζε ζεκείν, νξίδεηαη ε θαηεχζπλζε κε ην πνληίθη θαη ε 

απφζηαζε ηνπ ζεκείνπ απφ ην πξνεγνχκελφ ηνπ ζεκείν.  

Τν Ortho φκσο καο ππνρξεψλεη λα ρξεζηκνπνηνχκε κφλν δπν δηεπζχλζεηο (θάζεηα 

θαη νξηδφληηα). Μηα παξφκνηα ιεηηνπξγία θαη ε νπνία ζεσξείηαη σο ππεξζχλνιν ηεο 

Ortho είλαη ε ιεηηνπξγία Polar. Με ηελ ρξήζε ηνπ Polar κπνξνχκε λα 

ρξεζηκνπνηήζνπκε φζεο δηεπζχλζεηο ζέινπκε, ελψ ηαπηφρξνλα δελ καο εκπνδίδεη λα 

ρξεζηκνπνηήζνπκε θαη ηηο ελδηάκεζεο δηεπζχλζεηο, ρσξίο φκσο θακία αθξίβεηα.  
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2.5 Δνηολέρ Δπεξεπγαζίαρ 

Καηά ηελ δηάξθεηα ζρεδίαζεο ησλ αληηθεηκέλσλ αιιά θαη κεηά ηελ νινθιήξσζε ηνπ 

ζρεδίνπ κπνξεί λα ρξεηαζηεί λα γίλνπλ ζπγθεθξηκέλεο αιιαγέο ζε θάπνηα απφ ηα 

αληηθείκελα ή ζε νιφθιεξν ην ζρέδην. Οη αιιαγέο απηέο θαηνξζψλνληαη κε ηελ ρξήζε 

ησλ εληνιψλ επεμεξγαζίαο.  

2.5.1 Δνηολέρ Δπεξεπγαζίαρ 

Υπάξρνπλ δπν δηαθνξεηηθνί ηξφπνη επηινγήο εληνιψλ επεμεξγαζίαο. Δπηιέγνληαο ην 

Modify απφ ην Menu ή επηιέγνληαο ηα θαηάιιεια εηθνλίδηα ζηελ γξακκή εξγαιείσλ. 

Ζ παξαθάησ εηθφλα δείρλεη ηνπο δπν απηνχο ηξφπνπο. Κάζε εληνιή πνπ θαίλεηαη ζηελ 

εηθφλα εμεγείηαη ζηηο αληίζηνηρεο παξαθάησ ελφηεηεο. 

 

Δηθφλα 26 : Δπηινγέο Δπεμεξγαζίαο (Modify) 

 

Move 

Ζ εληνιή Move κεηαθηλεί ηα επηιεγκέλα αληηθείκελα κέζσ ελφο δηαλχζκαηνο 

κεηαηφπηζεο. Αθνχ ελεξγνπνηήζνπκε ηελ εληνιή απηή ζηελ γξακκή εληνιψλ 

εκθαλίδεηαη ε εξψηεζε Select Objects (επέιεμε αληηθείκελα). Δπηιέγνπκε ην 

αληηθείκελν ή ηα αληηθείκελα πνπ ζα κεηαθηλεζνχλ ζχκθσλα κε ηνπο ηξφπνπο πνπ 
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αλαθέξζεθαλ ζην αληίζηνηρν θεθάιαην θαη παηψληαο ην Enter ζηελ γξακκή εληνιψλ 

εκθαλίδεηαη ε εξψηεζε Specify base point or [Displacement] (Πξνζδηόξηζε ην αξρηθό 

ζεκείν ή [Γηάλπζκα Μεηαηόπηζεο]). Δπηιέγνπκε ην πξψην ζεκείν ηνπ δηαλχζκαηνο 

κεηαηφπηζεο. Αθνχ επηιεγεί ην πξψην ζεκείν, εκθαλίδεηαη ε εξψηεζε Specify second 

point or <use first point as displacement> (Πξνζδηόξηζε ην δεύηεξν ζεκείν). 

Δπηιέγνπκε ην δεχηεξν ζεκείν ηνπ δηαλχζκαηνο κεηαηφπηζεο θαη κε απηφλ ηνλ ηξφπν 

νινθιεξψλεηαη ε κεηαθίλεζε.  

Copy 

Ζ εληνιή Copy ιεηηνπξγεί φπσο ε εληνιή Move κε ηελ δηαθνξά φηη εδψ ηα 

αληηθείκελα δελ κεηαθηλνχληαη απφ ηελ αξρηθή ηνπο ζέζε ζην ζρέδην, αιιά αληίγξαθά 

ηνπο ηνπνζεηνχληαη ζε δηάθνξα ζεκεία πάλσ ζην ζρέδην.  

Αθνχ ελεξγνπνηήζνπκε ηελ εληνιή απηή ζηελ γξακκή εληνιψλ εκθαλίδεηαη ε 

εξψηεζε Select Objects (επέιεμε αληηθείκελα). Δπηιέγνπκε ην αληηθείκελν ή ηα 

αληηθείκελα πνπ ζα αληηγξαθνχλ θαη παηψληαο ην Enter ζηελ γξακκή εληνιψλ 

εκθαλίδεηαη ε εξψηεζε Specify base point or [Displacement] (Πξνζδηόξηζε ην πξώην 

ζεκείν ή [Γηάλπζκα Μεηαηόπηζεο]). Δπηιέγνπκε ην ζεκείν απφ ην νπνίν ζα γίλεη ε 

κεηαθίλεζε ηνπ αληηγξάθνπ ηνπ αληηθεηκέλνπ. 

Αθνχ επηιεγεί ην ζεκείν, εκθαλίδεηαη ε εξψηεζε Specify second point or <use 

first point as displacement> (Πξνζδηόξηζε ην δεύηεξν ζεκείν). Με ην πνληίθη 

θαζνξίδεηαη ην ζεκείν πνπ ζα ηνπνζεηεζεί ην αληίγξαθν ηνπ αληηθεηκέλνπ, αιιηψο 

δίλνληαη ζπληεηαγκέλεο ζηελ γξακκή εξγαιείσλ πνπ θαζνξίδνπλ ηε ζέζε ηνπ ζεκείνπ 

πνπ επηιέρζεθε κεηά ηελ εξψηεζε Specify base point or [Displacement]. Κάλνληαο 

αξηζηεξφ θιηθ ζην ζεκείν απηφ θαη κεηά δεμί θιηθ θαη Enter νινθιεξψλεηαη ε 

αληηγξαθή ηνπ επηιεγκέλνπ αληηθεηκέλνπ.  

Erase 

Ζ εληνιή Erase δηαγξάθεη ηα επηιεγκέλα αληηθείκελα. Αθνχ ελεξγνπνηήζνπκε ηελ 

εληνιή απηή εκθαλίδεηαη ζηελ γξακκή εληνιψλ ε εξψηεζε Select Object. Μπνξνχλ λα 

επηιερζνχλ παξαπάλσ απφ έλα αληηθείκελν θάζε θνξά πνπ εθηειείηαη ε ζπγθεθξηκέλε 

εληνιή. Μεηά ηελ επηινγή νινθιεξψλεηαη ε δηαγξαθή παηψληαο δεμί θιηθ ή ην Enter.  

Rotate 

Με ηελ εληνιή Rotate ηα επηιεγκέλα αληηθείκελα πεξηζηξέθνληαη σο πξνο θάπνην 

θέληξν πεξηζηξνθήο. Δλεξγνπνηνχκε ηελ εληνιή απηή θαη ακέζσο ζηελ γξακκή 
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εληνιψλ εκθαλίδεηαη ε εξψηεζε Select Objects. Δπηιέγνπκε φια ηα αληηθείκελα πνπ 

πξέπεη λα πεξηζηξαθνχλ θαη παηψληαο ην Enter εκθαλίδεηαη ζηελ γξακκή εληνιψλ ε 

εξψηεζε Specify base point (Πξνζδηόξηζε ην βαζηθό ζεκείν). Δπηιέγνπκε ην θέληξν 

πεξηζηξνθήο ησλ επηιεγκέλσλ αληηθεηκέλσλ θαη κεηά ηελ επηινγή ηνπ εκθαλίδεηαη ε 

εξψηεζε Specify rotation angle or [Copy/Reference] (Πξνζδηόξηζε ηελ γσλία 

πεξηζηξνθήο). Ζ πεξηζηξνθή νινθιεξψλεηαη δίλνληαο ηελ γσλία πεξηζηξνθήο ζην 

πιεθηξνιφγην ή κεηαθηλψληαο ην πνληίθη θαη θάλνληαο αξηζηεξφ θιηθ ζε θάπνην 

ζεκείν πάλσ ζηελ πεξηνρή ζρεδίαζεο.  

Offset 

Ζ εληνιή Offset δεκηνπξγεί παξάιιεια αληίγξαθα αληηθεηκέλσλ ζε ζπγθεθξηκέλε 

απφζηαζε. Δλεξγνπνηψληαο ηελ εληνιή απηή εκθαλίδεηαη ζηελ γξακκή εληνιψλ ε 

εξψηεζε Specify offset distance or [Through/Erase/Layer]. Γίλνπκε κηα απφζηαζε θαη 

παηψληαο Enter εκθαλίδεηαη ε εξψηεζε Select object to offset or [Exit/Undo]. 

Δπηιέγνπκε ην αληηθείκελν θαη ζηελ γξακκή εληνιψλ εκθαλίδεηαη ε εξψηεζε Specify 

point on side to offset or[ Exit/Multiple/Undo]. Οξίδνπκε ην ζεκείν πνπ ζα 

δεκηνπξγεζεί ην αληίγξαθν θαη θάλνληαο θιηθ ζην ζεκείν απηφ ή πιεθηξνινγψληαο ην 

ζεκείν νινθιεξψλεηαη ε δεκηνπξγία ησλ παξάιιεισλ αληηγξάθσλ ηνπ επηιεγκέλνπ 

αληηθεηκέλνπ. Μπνξνχλ λα δεκηνπξγεζνχλ πνιιά αληίγξαθα εάλ ζηελ εξψηεζε Select 

object to offset or [Exit/Undo] επηιέμνπκε θαη άιιν αληηθείκελν αληί Exit ή Undo.  

Scale 

Ζ εληνιή Scale ρξεζηκνπνηείηαη γηα κεγέζπλζε ή ζκίθξπλζε αληηθεηκέλσλ σο πξνο 

έλα ζεκείν. Δλεξγνπνηψληαο ηελ εληνιή εκθαλίδεηαη ζηελ γξακκή εξγαιείσλ ε 

εξψηεζε Select Objects. Μπνξνχλ λα επηιερζνχλ πεξηζζφηεξα απφ έλα αληηθείκελα. 

Δπηιέγνπκε ην αληηθείκελν θαη παηψληαο Enter εκθαλίδεηαη ε εξψηεζε Specify base 

point (θαζόξηζε ην θέληξν θιηκάθσζεο). Αθνχ θαζνξίζνπκε ην θέληξν θιηκάθσζεο θαη 

παηήζνπκε ην Enter, ζηελ γξακκή εληνιψλ εκθαλίδεηαη ε εξψηεζε Specify scale 

factor or [Copy/Reference] (θαζόξηζε ηνλ παξάγνληα θιηκάθσζεο), ε νπνία δεηάεη ηνλ 

θαζνξηζκφ ηνπ παξάγνληα θιηκάθσζεο ν νπνίνο είλαη έλαο αξηζκφο. Ζ εληνιή 

νινθιεξψλεηαη αθνχ δψζνπκε ηνλ παξάγνληα θιηκάθσζεο ζηελ γξακκή εληνιψλ. 

Παξαδείγκαηνο ράξηλ εάλ δνζεί σο παξάγνληαο θιηκάθσζεο ν αξηζκφο 2 ην 

αληηθείκελν ζα δηπιαζηαζηεί.  
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Lengthen 

Με ηελ εληνιή Lengthen αιιάδεη ην κήθνο ησλ αληηθεηκέλσλ. Δπηιέγνπκε ηελ εληνιή 

απηή θαη ζηελ γξακκή εληνιψλ εκθαλίδεηαη ε εξψηεζε Select an object or 

[DElta/Percent/Total/DYnamic] . Δάλ επηιέμνπκε θάπνην αληηθείκελν ζηελ γξακκή 

εληνιψλ εκθαλίδνληαη πιεξνθνξίεο ζρεηηθά κε ην κήθνο ηνπ επηιεγκέλνπ 

αληηθεηκέλνπ θαη επαλαιακβάλεηαη ε ίδηα εξψηεζε.  

Σε πεξίπησζε πνπ ην επηιεγκέλν αληηθείκελν είλαη ηφμν (θακππινεηδέο) ηφηε εθηφο 

απφ ην κήθνο εκθαλίδεηαη θαη ε γσλία ηνπ. Δάλ αληί ηελ επηινγή αληηθεηκέλνπ 

πιεθηξνινγήζνπκε θάπνηα απφ ηηο πξνηξνπέο πνπ βξίζθνληαη κέζα ζε αγθχιεο ηφηε 

αιιάδεη ην κήθνο ηνπ αληηθεηκέλνπ κε δηάθνξνπο ηξφπνπο. Σπγθεθξηκέλα αλαιχεηαη ε 

αιιαγή ηνπ κήθνπο γηα ηελ θάζε πξνηξνπή:  

 

DElta = αιιαγή κήθνπο ζαλ δηαθνξά κήθνπο ηνπ λένπ απφ ην παιηφ αληηθείκελν.  

Percent = αιιαγή κήθνπο ζαλ εθαηνζηηαίν πνζνζηφ ηνπ λένπ κήθνπο πξνο ην παιηφ.  

Total = θαζνξίδεηαη ην ζπλνιηθφ λέν κήθνο ηνπ αληηθεηκέλνπ.  

DYnamic = θαζνξίδεηαη ην λέν κήθνο ελφο αληηθεηκέλνπ πξνζδηνξίδνληαο λέα ζέζε γηα 

ην έλα ηνπ άθξν. 
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2.6 ΢σεδίαζη Γεωμεηπικών Ανηικειμένων 

Ζ ζρεδίαζε ζχλζεησλ θαη πνιχπινθσλ αληηθεηκέλσλ ζην AutoCAD γίλεηαη θπξίσο 

κέζσ δπν βαζηθψλ ηχπσλ αληηθεηκέλσλ, ησλ Linear Objects (γξακκηθά αληηθείκελα) 

θαη ησλ Curved Objects (θακππινεηδή αληηθείκελα).  

 

Τα Linear Objects πεξηιακβάλνπλ νληφηεηεο φπσο line, polyline, polygons θ.α. γηα 

ηελ ζρεδίαζε ησλ γξακκηθψλ ηκεκάησλ ησλ ζχλζεησλ αληηθεηκέλσλ.  

 

Τα Curved Objects πεξηιακβάλνπλ νληφηεηεο φπσο arcs, circles, ellipses θ.α. γηα 

ηελ ζρεδίαζε ησλ θακππινεηδψλ ηκεκάησλ ησλ ζχλζεησλ αληηθεηκέλσλ.  

 

Υπάξρνπλ ηξεηο ηξφπνη επηινγήο ησλ νληνηήησλ ζρεδίαζεο αληηθεηκέλσλ :  

Δπηινγή εληνιήο από ην κελνύ. 

 

Δηθφλα 27 : Δπηινγή νληνηήησλ ζρεδίαζεο απφ ην κελνχ Σρεδίαζε (Draw) 

 

Δπηινγή ηνπ θαηάιιεινπ εηθνληδίνπ από ηελ εξγαιεηνζήθε. 

 

Δηθφλα 28 : Δξγαιεηνζήθε επηινγήο νληνηήησλ ζρεδίαζεο 
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Πιεθηξνιόγεζε ηεο εληνιήο ζηελ γξακκή εληνιώλ. 

 

Δηθφλα 29: Σρεδίαζε αληηθεηκέλσλ απφ ηε γξακκή εληνιψλ 

2.6.1 Γπαμμικά Ανηικείμενα – Γπαμμή  

Αξρηθά επηιέγνπκε θαη ελεξγνπνηνχκε ηελ εληνιή Line ζχκθσλα κε έλαλ απφ ηνπο 

ηξεηο ηξφπνπο πνπ αλαθέξζεθαλ ζηελ πξνεγνχκελε ελφηεηα.  

 

Σηε γξακκή εληνιψλ εκθαλίδεηαη ε εξψηεζε “Specify first point” (πξνζδηόξηζε ην 

πξώην ζεκείν). Δίλαη ην πξψην δεδνκέλν πνπ δεηάεη ε εληνιή. Ο πξνζδηνξηζκφο ελφο 

ζεκείνπ γίλεηαη είηε θάλνληαο θιηθ νπνπδήπνηε πάλσ ζηελ πεξηνρή ζρεδίαζεο, είηε 

δίλνληαο ηηο ζπληεηαγκέλεο ζηελ γξακκή εληνιψλ.  

 

Αθνχ πξνζδηνξίζνπκε ην πξψην ζεκείν, ζηελ γξακκή εληνιψλ εκθαλίδεηαη ε 

εξψηεζε “Specify next point or [Undo]” (πξνζδηόξηζε ην επόκελν ζεκείν ή 

[Αθύξσζε]). Γίλνπκε ην επφκελν ζεκείν ηεο γξακκή ζχκθσλα κε ηα αλσηέξσ.  

 

Μεηά ηνλ πξνζδηνξηζκφ θαη ηνπ δεχηεξνπ ζεκείνπ ζηελ γξακκή εληνιψλ 

εκθαλίδεηαη θαη πάιη ε εξψηεζε “Specify next point or [Undo]”. Σην ζεκείν απηφ είηε 

επηιέγνπκε επφκελα ζεκεία γηα ηελ ζρεδίαζε ζπλερφκελσλ επζχγξακκσλ ηκεκάησλ, 

είηε νινθιεξψλνπκε ηελ εληνιή θάλνληαο δεμί θιηθ θαη Enter ή παηψληαο ην 

αληίζηνηρν πιήθηξν ζην πιεθηξνιφγην. 

2.6.2 Καμπςλοειδή Ανηικείμενα – Κύκλορ  

Δπηιέγνπκε θαη ελεξγνπνηνχκε ηελ εληνιή Circle ζχκθσλα κε ηνπο 

πξναλαθεξφκελνπο ηξφπνπο.  

Σηε γξακκή εληνιψλ εθηφο απφ ηελ πξνηξνπή γηα ηελ εηζαγσγή ηνπ θέληξνπ ηνπ 

θχθινπ ππάξρνπλ θαη θάπνηεο ελαιιαθηηθέο πξνηξνπέο κέζα ζε αγθχιεο. Υπάξρνπλ 

έμη δηαθνξεηηθνί ηξφπνη ζρεδίαζεο θχθινπ πνπ αλαθέξνληαη παξαθάησ θαη νη νπνίνη 

πεξηγξάθνληαη αλαιπηηθά ζηηο παξαθάησ ελφηεηεο :  

δίλνληαο ην θέληξν θαη ηελ αθηίλα ηνπ θύθινπ (C-R)  
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δίλνληαο ην θέληξν θαη ηελ δηάκεηξν ηνπ θύθινπ (C-D)  

δίλνληαο δπν ζεκεία από όπνπ ζα πεξλάεη ν θύθινο (2 Points)  

δίλνληαο ηξία ζεκεία από όπνπ ζα πεξλάεη ν θύθινο (3 Points)  

δίλνληαο ηξεηο επζείεο κε ηηο νπνίεο ζα εθάπηεηαη ν θύθινο (Tan Tan Tan)  

δίλνληαο δπν επζείεο κε ηηο νπνίεο εθάπηεηαη ν θύθινο θαη ηελ αθηίλα ηνπ θύθινπ (Tan 

Tan Radius)  

 

Γηα ηνλ θάζε ελαιιαθηηθφ ηξφπν ηζρχνπλ δηαθνξεηηθέο πξνηξνπέο.  

Γηα ηελ επηινγή θάζε δηαθνξεηηθνχ ηξφπνπ, πιεθηξνινγνχκε ζηελ γξακκή εληνιψλ 

ην/ηα αληίζηνηρα θεθαιαία γξάκκαηα. 

Κύκλορ CR – CD  

Ο απινχζηεξνο ηξφπνο ζρεδίαζεο θχθινπ είλαη δίλνληαο ην θέληξν θαη ηελ αθηίλα ή 

ηελ δηάκεηξφ ηνπ.  

 

Τν θέληξν νξίδεηαη θάλνληαο θιηθ νπνπδήπνηε πάλσ ζηελ πεξηνρή ζρεδίαζεο ή 

δίλνληαο ζπληεηαγκέλεο ζηελ γξακκή εληνιψλ.  

Ο πξνζδηνξηζκφο ηεο αθηίλαο ή ηεο δηακέηξνπ γίλεηαη κεηαθηλψληαο ην πνληίθη 

κέρξη ην επηζπκεηφ ζεκείν θαη θάλνληαο θιηθ ζην ζεκείν απηφ είηε πιεθηξνινγψληαο 

ηελ αθηίλα ή ηελ δηάκεηξν ζηελ γξακκή εληνιψλ.  

 

Τν παξαθάησ παξάδεηγκα αλαθέξεηαη ζηελ ζρεδίαζε θχθινπ δίλνληαο ην θέληξν 

θαη ηελ αθηίλα ή ην θέληξν θαη ηε δηάκεηξν.  

Δπηιέγνπκε ηελ εληνιή Circle κε ηνπο γλσζηνχο ηξφπνπο. Σηελ γξακκή εληνιψλ 

εκθαλίδεηαη ε εξψηεζε Specify center point for circle or [3P/2P/Ttr] (Πξνζδηόξηζε ην 

θέληξν ηνπ θύθινπ ή δηάιεμε κηα από ηηο πξνηξνπέο). Σηε γξακκή εληνιψλ 

πιεθηξνινγνχκε ηηο ζπληεηαγκέλεο (100,100) γηα ηνλ πξνζδηνξηζκφ ηνπ θέληξνπ ηνπ 

θχθινπ θαη Enter. Έπεηηα εκθαλίδεηαη ε εξψηεζε Specify radius of circle or 

[Diameter] (Πξνζδηόξηζε ηελ αθηίλα ηνπ θύθινπ ή [ Γηάκεηξνο]. Γίλνπκε ην κήθνο ηεο 

αθηίλαο 80 θαη παηψληαο Enter νινθιεξψλεηαη ε ζρεδίαζε ηνπ θχθινπ θέληξν-αθηίλα. 

Γεχηεξνο ηξφπνο είλαη κεηά ηελ ελεξγνπνίεζε ηεο εληνιήο Circle θαη αθνχ έρνπκε 

νξίδεη ην θέληξν λα παηάκε d γηα ηελ δηάκεηξν. Σηε γξακκή εληνιψλ εκθαλίδεηαη ε 

εξψηεζε Specify diameter of circle (Πξνζδηόξηζε ηελ δηάκεηξν ηνπ θύθινπ). 
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Πιεθηξνινγψληαο 160 γηα ην κήθνο ηεο δηακέηξνπ θαη Enter νινθιεξψλεηαη ε 

ζρεδίαζε ηνπ θχθινπ. 

Κύκλορ 2Ρ 

Έλαο δεχηεξνο ηξφπνο ζρεδίαζεο ηνπ θχθινπ είλαη νξίδνληαο δχν ζεκεία απφ ηα νπνία 

ζα πεξλάεη ν θχθινο. Τα δχν απηά ζεκεία κπνξνχλ λα δνζνχλ θάλνληαο θιηθ 

νπνπδήπνηε επηζπκνχκε ζηελ πεξηνρή ζρεδίαζεο ή πιεθηξνινγψληαο ηηο 

ζπληεηαγκέλεο ηνπο ζηελ γξακκή εληνιψλ.  

Σπλήζσο ζέινπκε ν θχθινο λα πεξλάεη απφ δχν γλσζηά ζεκεία ηνπ ζρεδίνπ. Έζησ φηη 

έρνπκε ζρεδηάζεη 2 γξακκέο θαη ζέινπκε έλα θχθιν πνπ λα πεξλάεη απφ κέζα ησλ δπν 

απηψλ γξακκψλ. Δλεξγνπνηνχκε ηελ εληνιή Circle θαη ζηελ γξακκή εληνιψλ 

εκθαλίδνληαη νη πξνηξνπέο δεκηνπξγίαο θχθινπ. Πιεθηξνινγνχκε 2P θαη ακέζσο 

εκθαλίδεηαη ε εξψηεζε Specify first end point of circle's diameter (Πξνζδηόξηζε ην 

πξώην άθξν ηεο δηακέηξνπ ηνπ θύθινπ). Πιεζηάδνληαο ην πνληίθη πξνο ηελ κία γξακκή 

κέρξη λα εκθαληζηεί ην ρξσκαηηζηφ ζπκβνιάθη πνπ δειψλεη ην midpoint θαη θάλνληαο 

θιηθ κφιηο εκθαληζηεί ην ζχκβνιν απηφ, έρεη πξνζδηνξηζηεί ην πξψην ζεκείν. Με ηνλ 

ίδην ηξφπν πξνζδηνξίδνπκε θαη ην ηειεπηαίν ζεκείν ηεο δηακέηξνπ ηνπ θχθινπ, 

θάλνληαο θιηθ ζην midpoint ηεο δεχηεξεο γξακκήο. Έηζη νινθιεξψλεηαη ε ζρεδίαζε 

θχθινπ πνπ πεξλάεη απφ δχν ζεκεία. 

Κύκλορ 3Ρ 

Με ηνλ ίδην ηξφπν πνπ δεκηνπξγήζεθε ν θχθινο πνπ πεξλάεη απφ δπν ζεκεία 

δεκηνπξγείηαη θαη ν θχθινο πνπ πεξλάεη απφ ηξία ζεκεία.  

 Δλεξγνπνηνχκε ηελ εληνιή Line θαη δεκηνπξγνχκε ηξεηο γξακκέο. Δλεξγνπνηνχκε 

ηελ εληνιή Circle θαη ζηελ γξακκή εληνιψλ εκθαλίδνληαη νη πξνηξνπέο δεκηνπξγίαο 

θχθινπ. Πιεθηξνινγνχκε 3P θαη ακέζσο εκθαλίδεηαη ε εξψηεζε Specify first point on 

circle (Πξνζδηόξηζε πξώην ζεκείν ηνπ θύθινπ). Πιεζηάδνπκε ην πνληίθη πξνο ηελ κία 

γξακκή κέρξη λα εκθαληζηεί ην ρξσκαηηζηφ ζπκβνιάθη πνπ δειψλεη ην endpoint θαη 

θάλνληαο θιηθ πξνζδηνξίδεηαη ην πξψην ζεκείν. Ακέζσο εκθαλίδεηαη ε εξψηεζε 

Specify second point on circle (Πξνζδηόξηζε δεύηεξν ζεκείν ηνπ θύθινπ). Με ηνλ ίδην 

ηξφπν πξνζδηνξίδνπκε θαη ην δεχηεξν ζεκείν θαη ακέζσο κεηά εκθαλίδεηαη ε εξψηεζε 

Specify third point on circle (Πξνζδηόξηζε ηξίην ζεκείν ηνπ θύθινπ). Έηζη 

νινθιεξψλεηαη ε ζρεδίαζε θχθινπ πνπ πεξλάεη απφ ηξία ζεκεία. 
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Κύκλορ TTR 

Γηα ηελ ζρεδίαζε θχθινπ πνπ εθάπηεηαη κε δχν αληηθείκελα θαη νξίδνπκε ηελ αθηίλα 

ηνπ, ρξεζηκνπνηείηαη θαη πάιη ε εληνιή Line. Γεκηνπξγνχκε δπν ηπραίεο γξακκέο. 

Δλεξγνπνηνχκε ηελ εληνιή Circle θαη επηιέγνπκε ηελ πξνηξνπή Ttr. Ακέζσο 

εκθαλίδεηαη ε εξψηεζε Specify point on object for first tangent of circle (πξνζδηόξηζε 

ζεκείν ηνπ αληηθεηκέλνπ γηα ηελ πξώηε εθαπηνκέλε ηνπ θύθινπ). Πιεζηάδνληαο κε ην 

πνληίθη πξνο ηελ πξψηε γξακκή θαη θάλνληαο θιηθ κφιηο εκθαληζηεί ην ρξσκαηηζηφ 

ζχκβνιν γηα ην tangent ηεο γξακκήο απηήο εκθαλίδεηαη ε εξώηεζε Specify point on 

object for second tangent of circle (πξνζδηόξηζε ζεκείν ηνπ αληηθεηκέλνπ γηα ηελ 

δεύηεξε εθαπηνκέλε ηνπ θύθινπ). Με ηνλ ίδην ηξφπν πξνζδηνξίδεηαη θαη ην δεχηεξν 

ζεκείν κε ζην νπνίν ζα εθάπηεηαη ν θχθινο. Μεηά ηνλ πξνζδηνξηζκφ ησλ δπν 

ζεκείσλ εκθαλίδεηαη ε εξψηεζε Specify radius of circle (πξνζδηόξηζε ηελ αθηίλα ηνπ 

θύθινπ).   

Σηελ γξακκή εληνιψλ πιεθηξνινγνχκε κία ηηκή γηα ην κήθνο ηεο αθηίλαο θαη κε 

Enter νινθιεξψλεηαη ε ζρεδίαζε.  

Κύκλορ ΣΣΣ 

Με ηνλ ίδην ηξφπν ζρεδηάδνπκε θαη ηνλ θχθιν πνπ εθάπηεηαη ζε ηξία ζεκεία, απιά 

αληί λα δνζνχλ δχν ζεκεία ζηα νπνία ζα εθάπηεηαη ν θχθινο θαη ε αθηίλα ηνπ, 

δίλνληαη ηξία ζεκεία.  

 

Δλεξγνπνηνχκε ηελ εληνιή Line θαη δεκηνπξγνχκε ηξεηο ηπραίεο γξακκέο. Απφ ην 

Menu -> Draw -> Circle επηιέγνπκε ηελ πξνηξνπή Tan Tan Tan. Ακέζσο εκθαλίδεηαη 

ε εξψηεζε Specify first point on circle (πξνζδηόξηζε ην πξώην ζεκείν). Πιεζηάδνληαο 

κε ην πνληίθη πξνο ηελ πξψηε γξακκή θαη θάλνληαο θιηθ κφιηο εκθαληζηεί ην 

ρξσκαηηζηφ ζχκβνιν εκθαλίδεηαη ε εξψηεζε Specify second point on circle 

(πξνζδηόξηζε ην δεύηεξν ζεκείν). Με ηνλ ίδην ηξφπν πξνζδηνξίδνπκε θαη ην δεχηεξν 

ζεκείν, θαη ακέζσο εκθαλίδεηαη ε εξψηεζε Specify third point on circle (πξνζδηόξηζε 

ην ηξίην ζεκείν) γηα ηνλ πξνζδηνξηζκφ ηξίηνπ ζεκείνπ. Αθνχ πξνζδηνξηζηνχλ θαη ηα 

ηξία ζεκεία νινθιεξψλεηαη ε ζρεδίαζε ηνπ θχθινπ. 
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2.7 Γιασείπιζη ΢ηπωμάηων 

Σην AutoCAD θάζε ζρέδην ρσξίδεηαη ζε παξαπάλσ απφ έλα ζηξψκαηα ζηα νπνία 

ζρεδηάδνληαη δηάθνξα ηκήκαηα ηνπ ηειηθνχ ζρεδίνπ. Καη' απηφλ ηνλ ηξφπν φηαλ 

γίλνληαη αιιαγέο ζε έλα θνκκάηη ηνπ ζρεδίνπ δελ επεξεάδεηαη ην ππφινηπν ζρέδην. 

Όια ηα ζηξψκαηα αλ ηνπνζεηεζνχλ ην έλα πάλσ ζην άιιν δίλνπλ ην ζπλνιηθφ ζρέδην.  

Κάζε ζηξψκα ραξαθηεξίδεηαη απφ δηάθνξεο ηδηφηεηεο νη νπνίεο ζα αλαθεξζνχλ 

αλαιπηηθά παξαθάησ.   

 

Δηθφλα 30 : Γηαρείξηζε ζηξσκάησλ  

 

Γηα ηελ δηαρείξηζε ζηξσκάησλ επηιέγεηαη Menu -> Format -> Layer (εηθφλα 42) ή 

ην θνπκπί Layers Properties Manager απφ ηελ γξακκή εξγαιεηψλ Layers (εηθφλα 43) 

 

Δηθφλα 31 : Κνπκπί επηινγήο ηδηνηήησλ ζηξσκάησλ 

 

θαη εκθαλίδεηαη ην παξαθάησ πιαίζην. 

 

Δηθφλα 32 : Παξάζπξν Ηδηνηήησλ Σηξσκάησλ 
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2.7.1 Layers 

Τν θάζε ζηξψκα ραξαθηεξίδεηαη απφ δηαθνξεηηθφ φλνκα. Σην πιαίζην δηαρείξηζεο 

ζηξσκάησλ θαίλεηαη έλα ζηξψκα κε φλνκα 0. Απηφ ην ζηξψκα δελ κπνξεί λα 

δηαγξαθεί ή λα κεηνλνκαζηεί.  

 

Γηα ηελ δεκηνπξγία λένπ ζηξψκαηνο επηιέγεηαη ην θνπκπί New ην νπνίν έρεη ζαλ 

αξρηθφ φλνκα Layer 1. Κάλνληαο θιηθ πάλσ ζηε ζηήιε Name δηνξζψλεηαη ην φλνκα 

ηνπ ζηξψκαηνο.  

 

Δηθφλα 33 : Γεκηνπξγία λένπ ζηξψκαηνο 

 

Γηα ηελ δηαγξαθή ελφο ζηξψκαηνο επηιέγεηαη ην ζηξψκα θαη παηψληαο ην θνπκπί 

Delete δηαγξάθεηαη, κε ηελ πξνυπφζεζε φηη δελ πεξηιακβάλεη θαλέλα αληηθείκελν.  

 

Δηθφλα 34 : Γηαγξαθή ζηξψκαηνο 

 

Απφ φια ηα ζηξψκαηα κφλν έλα κπνξεί λα είλαη ην ηξέρνλ. Ζ αιιαγή ηνπ 

ηξέρνληνο ζηξψκαηνο γίλεηαη επηιέγνληαο ην ζηξψκα θαη παηψληαο θιηθ ζην θνπκπί 

Current.  

 

Δηθφλα 35 : Δπηινγή ηξέρνληνο ζηξψκαηνο 

 

Τα ζηξψκαηα κπνξνχλ λα βξίζθνληαη ζε δπν θαηαζηάζεηο On/Off. Ζ αιιαγή ηεο 

θαηάζηαζεο γίλεηαη κε θιηθ πάλσ ζηελ αληίζηνηρε ιάκπα. Αξρηθά φια ηα ζηξψκαηα 
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βξίζθνληαη ζε θαηάζηαζε On. Όηαλ ηα ζηξψκαηα είλαη ζε θαηάζηαζε Off ηα 

αληηθείκελά ηνπο δελ θαίλνληαη αιιά ην AutoCAD ηα ιακβάλεη ππφςε θαηά ηελ 

ζρεδίαζε, δειαδή ζε πεξίπησζε πνπ εθηειεζηεί ε εληνιή Select All objects (επηινγή 

όισλ ησλ αληηθεηκέλσλ) επηιέγνληαη θαη ηα αληηθείκελα ησλ ζηξσκάησλ πνπ είλαη ζε 

θαηάζηαζε Off.  

 

Δηθφλα 36 : Δπηινγή φισλ ησλ αληηθεηκέλσλ 

 

Δπίζεο ηα ζηξψκαηα κπνξεί λα βξίζθνληαη ζε θαηάζηαζε Thaw/Freeze. Ζ αιιαγή 

ηεο θαηάζηαζεο γίλεηαη κε θιηθ πάλσ ζην αληίζηνηρν ζχκβνιν (ήιηνο γηα ηελ 

θαηάζηαζε Thaw θαη ληθάδα ρηνληνύ γηα ηελ θαηάζηαζε Freeze). Αξρηθά φια ηα 

ζηξψκαηα βξίζθνληαη ζε θαηάζηαζε Thaw. Δάλ ηα ζηξψκαηα βξίζθνληαη ζε 

θαηάζηαζε Freeze ηα αληηθείκελα ηνπο δελ είλαη νξαηά θαη ηαπηφρξνλα δελ 

ιακβάλνληαη ππφςε θαηά ηελ ζρεδίαζε. 

 

Δηθφλα 37 : Δπηινγή Freeze 

 

Μία άιιε θαηάζηαζε ζηελ νπνία βξίζθνληαη ηα ζηξψκαηα είλαη Unlock/Lock 

(θιεηδσκέλν/μεθιείδσην). Αξρηθά φια ηα ζηξψκαηα βξίζθνληαη ζε θαηάζηαζε 

Unlock. Γηα λα αιιάμεη ε θαηάζηαζε ελφο ζηξψκαηνο αξθεί έλα θιηθ ζην αληίζηνηρν 

ζχκβνιν (θιεηδαξηά). Όηαλ έλα ζηξψκα είλαη θιεηδσκέλν δελ κπνξεί λα γίλεη θακία 

ηξνπνπνίεζε ζηα αληηθείκελά ηνπ.  

 

Δηθφλα 38 : Κιείδσκα ζηξψκαηνο 
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Άιιν ραξαθηεξηζηηθφ ησλ ζηξσκάησλ είλαη ην ρξψκα Color. Ζ αιιαγή ρξψκαηνο 

γίλεηαη κε έλα θιηθ ζηελ αληίζηνηρε ζηήιε. Ακέζσο εκθαλίδεηαη έλα πιαίζην κε ηα 

ρξψκαηα. Τν ρξψκα πνπ νξίδεηαη γηα έλα ζηξψκα είλαη θαη ην ρξψκα πνπ ζα πάξνπλ 

ηα αληηθείκελα πνπ βξίζθνληαη ζην αληίζηνηρν ζηξψκα. 

 

Δηθφλα 39 : Αιιαγή ρξψκαηνο ηνπ ζηξψκαηνο  

 

Κάζε ζηξψκα θαζνξίδεηαη απφ έλαλ ηχπν γξακκήο Linetype, εάλ ε γξακκή ζα 

είλαη ζπλερήο ή δηαθεθνκκέλε. Γηα ηελ δηαθεθνκκέλε γξακκή ππάξρνπλ πνιινί ηχπνη. 

Ο ηχπνο ηεο γξακκήο θαζνξίδεηαη ζηελ ζηήιε Linetype ηνπ πιαηζίνπ. Κάλνληαο θιηθ 

εκθαλίδεηαη έλα άιιν πιαίζην θαη παηψληαο ην θνπκπί Load ζην πιαίζην απηφ 

εκθαλίδεηαη έλα άιιν πιαίζην κε ηνπο ηχπνπο ησλ γξακκψλ. Παηψληαο θιηθ πάλσ ζε 

θάπνην ηχπν γξακκήο θαη κεηά ην θνπκπί OK επηιέγεηαη ν ηχπνο ηεο γξακκήο. 

 

Δηθφλα 40 : Αιιαγή ηχπνπ γξακκήο 

 

Δθηφο απφ ηνλ ηχπν ππάξρεη θαη ην πάρνο ηεο γξακκήο Lineweight, ην νπνίν 

θαζνξίδεηαη κε θιηθ πάλσ ζηελ αληίζηνηρε ζηήιε Lineweight. Αθνχ εκθαλίδεηαη ην 

πιαίζην θαη παηψληαο θιηθ ζην επηζπκεηφ πάρνο γξακκήο θαη ην θνπκπί OK 

θαζνξίδεηαη ην πάρνο ηεο γξακκήο.  

 

Δηθφλα 41 : Αιιαγή πάρνπο γξακκήο 

 

Δθηφο απφ ηα ραξαθηεξηζηηθά απηά ππάξρεη θαη ε ζηήιε Plot πνπ θαζνξίδεη εάλ ηα 

αληηθείκελα ηνπ θάζε ζηξψκαηνο ζα εθηππσζνχλ ή φρη. Αλ ζην ζηξψκα ππάξρεη ην 
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εηθνλίδην κε ηνλ εθηππσηή ηφηε ηα αληηθείκελα ηνπ αληίζηνηρνπ ζηξψκαηνο ζα 

εθηππσζνχλ. Σε πεξίπησζε πνπ ζην ζηξψκα ππάξρεη εηθνλίδην εθηππσηή κε έλα 

απαγνξεπηηθφ ζήκα, ηφηε δελ κπνξνχλ λα εθηππσζνχλ ηα αληηθείκελα ηνπ ζηξψκαηνο 

απηνχ.  
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2.8 Κείμενο 

Τν AutoCAD παξέρεη ηελ δπλαηφηεηα εηζαγσγήο θεηκέλνπ. Γηα ηελ εηζαγσγή κηαο 

κεκνλσκέλεο γξακκήο πιεθηξνινγνχκε ηελ εληνιή dtext ή πεγαίλνληαο ζην Menu -> 

Draw -> Text -> Single line text.  

 

Δηθφλα 42 : Δπηινγή Δηζαγσγήο Κεηκέλνπ 

 

Δλψ γηα ηελ εηζαγσγή κηαο παξαγξάθνπ θεηκέλνπ αθνινπζείηαη ε δηαδξνκή Menu 

-> Draw -> Text -> Multiline text φπσο θαίλεηαη ζηελ παξαπάλσ εηθφλα, είηε 

επηιέγνληαο ην θαηάιιειν εηθνλίδην απφ ηελ εξγαιεηνζήθε  

Όηαλ επηιέγνπκε ηελ εηζαγσγή κεκνλσκέλεο γξακκήο θεηκέλνπ ζηελ γξακκή 

εξγαιείσλ εκθαλίδεηαη ε εξψηεζε Specify start point of text or [Justify/Style] 

(πξνζδηόξηζε ζεκείν εθθίλεζεο ηνπ θεηκέλνπ). Καζνξίδνπκε ην ζεκείν εηζαγσγήο 

θεηκέλνπ θάλνληαο θιηθ ζηελ πεξηνρή ζρεδίαζεο ή δίλνληαο ηηο ζπληεηαγκέλεο θαη 

Enter. Δκθαλίδεηαη ε δεχηεξε εξψηεζε Specify height (πξνζδηόξηζε ην ύςνο). Γίλνπκε 

κηα ηηκή γηα ην χςνο θαη Enter. Ακέζσο εκθαλίδεηαη ε εξώηεζε Specify rotation angle 

of text (πξνζδηόξηζε ηελ γσλία πεξηζηξνθήο ηνπ θεηκέλνπ).Ζ γσλία απηή πεξηζηξέθεη ην 

θείκελν θαη ΓΔΝ πιαγηάδεη ηνπο ραξαθηήξεο ηνπ θεηκέλνπ. Καη ηέινο δεηείηαη λα 

πιεθηξνινγεζεί ην θείκελν. Σηελ πιεθηξνιφγεζε ηνπ θεηκέλνπ επηηξέπνληαη ηα θελά 

δηαζηήκαηα. Ζ γξακκή νινθιεξψλεηαη παηψληαο Enter. Μεηά ηελ νινθιήξσζε ηεο 

γξακκήο επαλαιακβάλεηαη πάιη ε εξψηεζε γηα ηελ εηζαγσγή θεηκέλνπ, ε νπνία δίλεη 

ηελ δπλαηφηεηα εηζαγσγήο πνιιψλ γξακκψλ θεηκέλνπ ηελ κία θάησ απφ ηελ άιιε. Ζ 

εηζαγσγή θεηκέλνπ νινθιεξψλεηαη παηψληαο δπν ζπλερφκελεο θνξέο ην πιήθηξν 

Enter. Ζ θάζε γξακκή θεηκέλνπ απνηειεί μερσξηζηφ αληηθείκελν ζρεδίαζεο.  
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Δηθφλα 43 : Γηακφξθσζε Κεηκέλνπ 

 

Δάλ επηιέγνπκε ηελ εηζαγσγή παξαγξάθνπ θεηκέλνπ ηφηε εκθαλίδεηαη ε εξψηεζε 

Specify first corner ε νπνία δεηά ηελ επηινγή ελφο ζεκείνπ εηζαγσγήο θεηκέλνπ. 

Δπηιέγνπκε ην ζεκείν θάλνληαο θιηθ ζηελ πεξηνρή ζρεδίαζεο ή δίλνληαο ηηο 

ζπληεηαγκέλεο θαη Enter θαη ακέζσο εκθαλίδεηαη ε εξψηεζε Specify opposite corner 

or [Height/Justify/Line spacing/Rotation/Style/Width/Columns] ε νπνία δεηάεη ηελ 

εηζαγσγή ελφο δεχηεξνπ ζεκείνπ, ην νπνίν καδί κε ην πξψην ζεκείν νξίδνπλ ην 

νξζνγψλην πιαίζην κέζα ζην νπνίν ζα ηνπνζεηεζεί ε παξάγξαθνο θεηκέλνπ. Αθνχ 

δψζνπκε θαη ην δεχηεξν ζεκείν εκθαλίδεηαη ην πιαίζην ζην νπνίν ζα γξαθεί ην 

θείκελν.  

Μέζα ζην πιαίζην κε ηνλ ράξαθα γξάθνπκε ην θείκελν θαη ζηελ γξακκή 

εξγαιείσλ Text Formatting θαζνξίδνπκε ην ζηπι ηνπ θεηκέλνπ. Αθνχ έρεη γξαθηεί φιν 

ην θείκελν, παηψληαο ην θνπκπί OK ζηελ γξακκή εξγαιείσλ Text Formatting γίλεηαη ε 

επηζηξνθή ζην ζρέδην.  

2.8.1 Δπεξεπγαζία Κειμένος 

Σε πεξίπησζε πνπ ρξεηαζηεί θάπνηα επεμεξγαζία ζην θείκελν πνπ ππάξρεη ζην ζρέδην 

δίλνπκε ηελ εληνιή ddedit ή επηιέγνπκε ην θνπκπί Edit Text ηεο γξακκήο εξγαιείσλ 

Text ή Menu -> Modify -> Object - > Text -> Edit...  
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Δηθφλα 44 : Δπηινγή επεμεξγαζίαο θεηκέλνπ 

 

Ακέζσο εκθαλίδεηαη ε εξψηεζε Select an annotation object or [Undo] ην νπνίν 

δεηάεη ηελ επηινγή θεηκέλνπ ην νπνίν ζα επεμεξγαζηνχκε. Δάλ ην θείκελν είλαη 

κεκνλσκέλε γξακκή θεηκέλνπ ηφηε εκθαλίδεηαη ην παξαθάησ πιαίζην ην νπνίν 

επηηξέπεη ηελ επεμεξγαζία θεηκέλνπ.  

 

Δηθφλα 45 : Πιαίζην εηζαγσγήο θεηκέλνπ 

 

Σε πεξίπησζε πνπ ζα γίλεη επεμεξγαζία γηα παξάγξαθν θεηκέλνπ εκθαλίδεηαη ε 

εξψηεζε Select an annotation object or [Undo] ην νπνίν δεηάεη ηελ επηινγή θεηκέλνπ 

ην νπνίν ζα επεμεξγαζηεί. Δπηιέγνπκε ην θείκελν θαη ακέζσο εκθαλίδεηαη ην πιαίζην 

ην νπνίν εκθαλίζηεθε θαη ζηελ εηζαγσγή παξαγξάθνπ θεηκέλνπ. Αθνχ νινθιεξσζνχλ 

νη αιιαγέο κε έλα θιηθ ζην θνπκπί OK ηνπ πιαηζίνπ νινθιεξψλεηαη θαη ε 

επεμεξγαζία θεηκέλνπ.  

Έλαο άιινο ηξφπνο επεμεξγαζίαο θεηκέλνπ είλαη επηιέγνληαο ην θείκελν (έλα ή 

πεξηζζφηεξα αληηθείκελα θεηκέλνπ), είηε είλαη κεκνλσκέλε γξακκή είηε είλαη 

παξάγξαθνο θεηκέλνπ. Παηψληαο δεμί θιηθ θαη Properties εκθαλίδεηαη έλα πιαίζην 

ζην νπνίν κπνξνχλ λα γίλνπλ αιιαγέο ζην θεηκέλνπ.  
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Δηθφλα 46 : Παξάζπξν Ηδηνηήησλ Κεηκέλνπ 

 

2.8.2 Δκηύπωζη 

Γηα ηελ εθηχπσζε ελφο ζρεδίνπ επηιέγνπκε Menu -> File -> Plot. Ακέζσο 

εκθαλίδεηαη έλα πιαίζην δηαιφγνπ ζην νπνίν γίλνληαη δηάθνξεο επηινγέο ζρεηηθά κε 

ηελ εθηχπσζε.  

Σηελ πεξηνρή Page setup δίλνληαο θάπνην φλνκα ζηελ ιίζηα Name απνζεθεχεηαη 

ην ηξέρνλ ζχλνιν ξπζκίζεσλ. Γηα λα πξνζηεζεί έλα άιιν φλνκα ζηε ιίζηα επηιέγνπκε 

ην θνπκπί Add , πιεθηξνινγνχκε ην φλνκα θαη παηάκε ην θνπκπί OK. Αθνχ 

απνζεθεπηνχλ νη ξπζκίζεηο απηέο κπνξνχλ λα μαλαρξεζηκνπνηεζνχλ επηιέγνληαο 

απιά ην φλνκα ηεο νκάδαο ξπζκίζεσλ απφ ηελ ιίζηα Page setup -> Name.  

Σηελ πεξηνρή Printer/plotter γίλνληαη επηινγέο ζρεηηθά κε ηνλ εθηππσηή.  

Σηελ ιίζηα Name επηιέγνπκε ην φλνκα ηνπ εθηππσηή. Αθξηβψο ζηα δεμηά ηεο ιίζηαο 

Name ππάξρεη ην θνπκπί Properties ην νπνίν αλ παηεζεί εκθαλίδεηαη έλα δεχηεξν 

πιαίζην ζρεηηθά κε ηηο ηδηφηεηεο ηνπ εθηππσηή. Σε πεξίπησζε πνπ επηιέγεηαη ην Plot 

to File ηεο πεξηνρήο απηήο ηφηε ε εθηχπσζε ζηέιλεηαη ζε θάπνην αξρείν ην νπνίν 

θαζνξίδεηαη απφ ηνλ ρξήζηε, θαη φρη ζηνλ εθηππσηή.  
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Δηθφλα 47: Παξάζπξν Δθηππψζεσο 

 

Σηελ πεξηνρή Paper size θαζνξίδνπκε ην κέγεζνο ηνπ ραξηηνχ θαη αθξηβψο ζηα 

δεμηά ππάξρεη ε πεξηνρή Number of copies πνπ θαζνξίδνπκε ηνλ αξηζκφ ησλ 

αληίγξαθσλ ηνπ ζρεδίνπ πνπ ζα εθηππσζεί.  

Σηελ πεξηνρή Plot area θαζνξίδνπκε πνηα πεξηνρή ηνπ ζρεδίνπ ζα εθηππσζεί.  

Limits = εθηχπσζε φιεο ηεο πεξηνρήο πνπ νξίδεηαη απφ ηα φξηα ηνπ ζρεδίνπ.  

Display = εθηππψλεη νηηδήπνηε θαίλεηαη ζηελ νζφλε.  

Window = φηαλ επηιέγνπκε ην Window ην πιαίζην δηαιφγνπ θξχβεηαη πξνζσξηλά θαη 

εκθαλίδεηαη ε πεξηνρή ζρεδίαζεο ηνπ AutoCAD κέρξη λα επηιέμνπκε κηα πεξηνρή ηα 

πεξηερφκελα ηεο νπνίαο ζα εθηππσζνχλ. Αθνχ έρνπκε επηιέμεη ηελ πεξηνρή 

εθηχπσζεο εκθαλίδεηαη πάιη ην πιαίζην δηαιφγνπ κε ην Window επηιεγκέλν.  
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Σηα δεμηά ηεο πεξηνρήο απηήο ππάξρεη ε πεξηνρή Plot scale απφ φπνπ θαζνξίδνπκε 

ηε θιίκαθα ηεο εθηχπσζεο θαη ηελ αληηζηνηρία κεηαμχ ρηιηνζηψλ ζην ραξηί mm θαη 

ζρεδηαζηηθψλ κνλάδσλ ζην ζρέδην units. Δάλ επηιέμνπκε ην Fit to paper ηφηε ην 

AutoCAD ππνινγίδεη απφ κφλν ηνπ ηελ αληηζηνηρία ρηιηνζηψλ θαη ζρεδηαζηηθψλ 

κνλάδσλ, έηζη ψζηε ην ζρέδην πνπ έρνπκε επηιέμεη λα ρσξάεη αθξηβψο ζην ραξηί. 

Δπίζεο θαζνξίδνπκε ην πάρνο ησλ γξακκψλ ηζεθάξνληαο ην Scale linewights αιιηψο 

φιεο νη γξακκέο εθηππψλνληαη κε ην ίδην πάρνο.  

Σηελ πεξηνρή Plot offset (origin set to printable area) θεληξάξεηαη ε πεξηνρή πξνο 

εθηχπσζε ζην ραξηί ηεο εθηχπσζεο. Τν θεληξάξηζκα κπνξεί λα γίλεη απηφκαηα αλ 

επηιέμνπκε ην θνπκπί Center the plot είηε πιεθηξνινγψληαο ηηο ζπληεηαγκέλεο ζηα 

αληίζηνηρα πιαίζην X θαη Y.  

Γηα ηελ πξνβνιή εθηχπσζεο επηιέγνπκε ην θνπκπί Preview ην νπνίν βξίζθεηαη 

θάησ αξηζηεξά ηνπ πιαηζίνπ. Τν πιαίζην δηαιφγνπ θξχβεηαη πξνζσξηλά θαη 

εκθαλίδεηαη ε πεξηνρή ζρεδίαζεο κε ην απνηέιεζκα ηεο ζρεδίαζεο ζε πξαγκαηηθή 

πξνεπηζθφπεζε. Γηα ηελ επηζηξνθή ζην πιαίζην δηαιφγνπ επηιέγεηαη ην Enter ή ην Esc 

απφ ην πιεθηξνιφγην.  

Αθνχ έρνπλ γίλεη νη θαηάιιειεο επηινγέο νινθιεξψλεηαη ε εθηχπσζε ηνπ ζρεδίνπ 

παηψληαο ην θνπκπί OK απφ ην πιαίζην δηαιφγνπ. 

2.8.3 Δκηύπωζη ζε Κλίμακα 

Όπσο πξναλαθέξζεθε, κηα απφ ηηο επηινγέο ηεο εθηχπσζεο είλαη θαη ε επηινγή 

Plot scale. Με ηελ επηινγή απηή ν ρξήζηεο έρεη ηε δπλαηφηεηα λα εθηππψζεη ην 

ζρέδηφ ηνπ ζε νπνηαδήπνηε θιίκαθα επηζπκεί. Υπάξρνπλ δπν δπλαηφηεηεο, είηε λα 

επηιεγεί κηα απφ ηηο ήδε νξηζκέλεο θιίκαθεο πνπ πεξηιακβάλνληαη ζην πξψην πιαίζην 

είηε λα νξηζηεί κηα νπνηαδήπνηε άιιε θιίκαθα απφ ηα πιαίζηα αληηζηνηρίαο 

ζρεδηαζηηθψλ κνλάδσλ units θαη κνλάδαο κέηξεζεο (mm). 

Παξαδείγκαηνο ράξε, αλ επηιέμνπκε ηελ θιίκαθα 1:2, ζην ραξηί φπνπ ζα 

εθηππσζεί ζρέδην νη 2 ζρεδηαζηηθέο κνλάδεο ζα έρνπλ κήθνο 1 ρηιηνζηφ. Δπίζεο, αλ 

είλαη επηζπκεηφ θαηά ηελ εθηχπσζε ε κηα ζρεδηαζηηθή κνλάδα λα αληηζηνηρεί ζε έλα 

κέηξν ζην ραξηί, ηφηε ζηα πιαίζηα αληηζηνηρίαο πιεθηξνινγνχκε ηελ ηηκή 1000 ζην 

mm θαη 1 ζην units.  
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2.8.4 Γιαζηάζειρ 

Σην AutoCAD ππάξρνπλ πνιιά είδε δηαζηάζεσλ ηα νπνία κπνξνχλ λα ζρεδηαζηνχλ 

θαη λα ρξεζηκνπνηεζνχλ ζην ζρέδην.  

 Γηαζηάζεηο κήθνπο  

 Γηαζηάζεηο γσλίαο  

 Αθηίλεο θχθισλ θαη ηφμσλ  

 Γηάκεηξνη θχθισλ θαη ηφμσλ  

 Σπληεηαγκέλεο ζεκείνπ  

 Γξακκέο νδεγφο  

Linear dimensions are used for dimensioning either horizontal or vertical distances.  

Aligned dimensions will measure the actual length of an angled line.  

Radius dimensions will give you the radius of either arcs or circles.  

Diameter dimensions are used on circles.  

Angular dimensions will measure the angle between two lines that you pick.  

Baseline dimensions are a special type that will automatically stack dimensions along 

one  plane as you pick points.  

 

Πεγαίλνληαο ζην Menu -> Dimension ή κε δεμί θιηθ πάλσ ζε νπνηαδήπνηε γξακκή 

εξγαιείσλ ηζεθάξνπκε κε έλα θιηθ ηελ επηινγή Dimension. Δκθαλίδεηαη ην παξαθάησ 

πιαίζην απ' φπνπ επηιέγνπκε ην είδνο δηαζηάζεσλ.  

 

Δηθφλα 48 : Δξγαιεηνζήθε Γηαζηάζεσλ (Dimension)  

 

Linear Dimension = ζρεδηάδεη γξακκηθέο δηαζηάζεηο ζε νξηδφληηα θαη θαηαθφξπθε 

δηεχζπλζε. Παηψληαο ην θνπκπί απηφ εκθαλίδεηαη ε εξψηεζε Specify first extension 

line origin or <select object>. Καζνξίδνπκε ην πξψην ζεκείν θαη χζηεξα εκθαλίδεηαη 

ε εξψηεζε Specify second extension line origin ε νπνία δεηάεη ηνλ θαζνξηζκφ ηνπ 

δεχηεξνπ ζεκείνπ. Αθνχ πξνζδηνξηζηνχλ θαη ηα δπν ζεκεία εκθαλίδεηαη ε εξψηεζε 

Specify dimension line location or [Mtext/Text/Angle/Horizontal/Vertical/Rotated] πνπ 



 

  48 

καο δεηάεη ηνλ θαζνξηζκφ ηεο ζέζεο ηεο δηάζηαζεο. Δπηιέγνπκε ηελ ζέζε θαη κε έλα 

θιηθ νινθιεξψλνπκε ηελ ζρεδίαζε δηάζηαζεο. 

 

Aligned Dimension = ζρεδηάδεη γξακκηθέο δηαζηάζεηο ζε δηεχζπλζε παξάιιειε 

πξνο ηα δχν ζεκεία ηελ απφζηαζε ησλ νπνίσλ κεηξάεη. Παηψληαο ην θνπκπί απηφ 

εκθαλίδεηαη ε εξψηεζε Specify first extension line origin or <select object>. 

Καζνξίδνπκε ην πξψην ζεκείν θαη χζηεξα εκθαλίδεηαη ε εξψηεζε Specify second 

extension line origin ε νπνία καο δεηάεη ηνλ θαζνξηζκφ ηνπ δεχηεξνπ ζεκείνπ. Αθνχ 

πξνζδηνξηζηνχλ θαη ηα δπν ζεκεία εκθαλίδεηαη ε εξψηεζε Specify dimension line 

location or [Mtext/Text/Angle] ε νπνία δεηάεη ηνλ θαζνξηζκφ ηεο ζέζεο ηεο 

δηάζηαζεο. Δπηιέγεηαη ε ζέζε θαη κε έλα θιηθ νινθιεξψλεηαη ε ζρεδίαζε ηεο 

δηάζηαζεο.  

 

Radius Dimension = εκθαλίδεη δηαζηάζεηο δηακέηξνπ θχθισλ θαη ηφμσλ. 

Δπηιέγνληαο ην θνπκπί απηφ εκθαλίδεηαη ε εξψηεζε Select arc or circle (Δπέιεμε ηόμν 

ή θύθιν). Αθνχ επηιέμνπκε θάπνην ηφμν ή θχθιν εκθαλίδεηαη ε δεχηεξε εξψηεζε 

Specify dimension line location or [Mtext/Text/Angle] ε νπνία δεηάεη ηνλ θαζνξηζκφ 

ηεο ζέζεο ζηελ νπνία ζα εκθαληζηεί ε αθηίλα ή ε δηάκεηξνο. Με ηελ επηινγή ηεο 

ζέζεο νινθιεξψλεηαη ε εληνιή. 

 

Angular Dimension = εκθαλίδεη δηαζηάζεηο γσληψλ. Δπηιέγνληαο ην αληίζηνηρν 

θνπκπί εκθαλίδεηαη ε εξψηεζε Select arc,circle,line, or <specify vertex> πνπ καο 

δεηάεη λα επηιέμνπκε έλα αληηθείκελν γηα ηνλ πξνζδηνξηζκφ ηεο γσλίαο πνπ ζα 

κεηξεζεί. Σχκθσλα κε ηελ θάζε επηινγή (ηφμν, θχθινο ή γσλία) εκθαλίδεηαη θαη κηα 

αληίζηνηρε εξψηεζε δεηψληαο καο λα θαζνξίζνπκε ηε ζέζε ζηελ νπνία ζα εκθαληζηεί 

ε γξακκή δηάζηαζεο.  

 

Ordinate Dimension = εκθαλίδεη ηηο ζπληεηαγκέλεο ζεκείσλ κέζα ζην ζρέδην. 

Δλεξγνπνηψληαο ηελ εληνιή απηή εκθαλίδεηαη ε εξψηεζε Specify feature location ε 

νπνία δεηάεη ηνλ θαζνξηζκφ ηνπ ζεκείνπ ηνπ νπνίνπ ζα εκθαληζηνχλ νη 

ζπληεηαγκέλεο. Αθνχ θαζνξίζνπκε ην ζεκείν εκθαλίδεηαη ε δεχηεξε εξψηεζε Specify 
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leader endpoint or [Xdatum/Ydatum/Mtext/Text/Angle] ε νπνία δεηάεη ηνλ θαζνξηζκφ 

ηεο ζέζεο ζηελ νπνία ζα εκθαληζηνχλ νη ζπληεηαγκέλεο. 

2.8.5 Αλλαγή Ιδιοηήηων Γιαζηάζεων 

Όηαλ νινθιεξψλεηαη κηα δηάζηαζε ππάξρεη ε δπλαηφηεηα αιιαγήο ηνπ θεηκέλνπ ή ηεο 

ζέζεο ή ηεο θιίζεο ηεο δηάζηαζεο. Γηα ηελ αιιαγή ζέζεο ηνπ θεηκέλνπ επηιέγνπκε 

Menu -> Dimension -> Align Text -> Left,Center,Right γηα κεηαηφπηζε αξηζηεξά, ζην 

θέληξν θαη δεμηά αληίζηνηρα. Μεηά ηελ επηινγή εκθαλίδεηαη ε εξψηεζε Select 

dimension ε νπνία δεηάεη ηελ επηινγή κίαο δηάζηαζεο. Μεηά ηελ επηινγή ην θείκελν 

ηνπνζεηείηαη ζηελ επηιεγκέλε ζέζε.  

Δπίζεο πεγαίλνληαο ζην Dimension Edit ηεο γξακκήο εξγαιείσλ θαη παηψληαο ην 

θνπκπί εκθαλίδεηαη ε εξψηεζε Enter type of dimension editing 

[Home/New/Rotate/Oblique] <Home> φπνπ αλ επηιεγεί ην Home επαλαθέξεη ην 

θείκελν ζηελ αξρηθή ηνπ ζέζε, ην New είλαη γηα αιιαγή θεηκέλνπ, ην Rotate 

πεξηζηξέθεη ην θείκελν ηεο δηάζηαζεο θαη ην Oblique δίλεη θάπνηα θιίζε ζηηο γξακκέο 

πξνέθηαζεο ηεο δηάζηαζεο. 
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3 Μεηαθορά Διδακηικής Εμπειρίας 

Με δεδνκέλν ην πφζν ρξνλνβφξν είλαη λα θαηαζθεπαζηεί εθπαηδεπηηθφ πνιπκεζηθφ 

πιηθφ θαζψο θαη ηελ πνιππινθφηεηα ηνπ ACAD, ζεσξήζεθε ζθφπηκν λα ιεθζεί 

ππφςε ε καθξφρξνλε εκπεηξία ελφο δηδάζθνληα ηνπ ACAD (κε πίλαθα, projector θαη 

ζέζε εξγαζίαο Ζ/Υ γηα θάζε καζεηή). 

 Ζ νδφο πνπ αθνινπζήζεθε ηειηθά ήηαλ λα κειεηεζεί ην πιηθφ ηνπ έκπεηξνπ 

δηδάζθνληα ACAD θαη λα δεκηνπξγεζεί θαηάιιειν νπηηθναθνπζηηθφ πιηθφ 

θαηαγξάθνληαο ζε video ηηο δξαζηεξηφηεηεο εληφο ηνπ ACAD ζην πιαίζην ηεο 

παξνπζίαζεο ησλ εξγαιείσλ πνπ παξέρεη γηα ζρεδίαζε. Γηα ην ζθνπφ απηφ 

ρξεζηκνπνηήζεθε ην ινγηζκηθφ Camtasia πνπ επηηξέπεη ηελ θαηαγξαθή ζε video θαη 

ήρν ηεο δξαζηεξηφηεηαο ελφο ρξήζηε κπξνζηά ζε κηα εθαξκνγή Ζ/Υ.  

3.1 Camtasia 

Τν Camtasia Studio είλαη έλα πξφγξακκα ηεο εηαηξείαο TechSmith, ην νπνίν πεξηέρεη 

εθαξκνγέο νη νπνίεο ζπλεξγάδνληαη γηα λα δεκηνπξγείηαη έλα νινθιεξσκέλν παθέην 

γηα ηελ θαηαγξαθή, επεμεξγαζία θαη παξνπζίαζε βίληεν ζηελ νζφλε. Αο δνχκε πνηεο 

είλαη απηέο νη εθαξκνγέο:  

Camtasia Studio: Τν Camtasia Studio καο επηηξέπεη λα θηάζνπκε ζε έλα επξχ 

θνηλφ θαη παξέρεη πνιινχο ηξφπνπο γηα ηε δηαλνκή ησλ βίληεφ καο. Οη ξπζκίζεηο ηνπ 

Camtasia Studio Project θαη ην SmartFocus καο επηηξέπνπλ λα αιιάμνπκε γξήγνξα ηηο 

δηαζηάζεηο ελφο βίληεν ψζηε λα ην παξνπζηάζνπκε θαη λα ην πξνσζήζνπκε ζε 

δηαθνξεηηθνχο πξννξηζκνχο φπσο: 

 Γεκηνπξγία αξρείνπ Flash γηα αλέβαζκα ζην Web 

 Γεκηνπξγία βίληεν ζε format CD-Ready 

 Γεκηνπξγία αξρείνπ βίληεν iPod  κε ηηο ζσζηέο δηαζηάζεηο θαη θσδηθνπνίεζε 

 Γεκηνπξγία βίληεν DVD-Ready γηα ρξήζε κε ηα πεξηζζφηεξα πξνγξάκκαηα 

επεμεξγαζίαο DVD άιισλ θαηαζθεπαζηψλ 

 

http://translate.googleusercontent.com/translate_c?hl=el&sl=en&u=http://en.wikipedia.org/wiki/TechSmith&prev=/search%3Fq%3Dcamtasia%26hl%3Del&rurl=translate.google.gr&usg=ALkJrhgncK4drnKF1WhBA4EAaL1apgctWg
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Δηθφλα 49: Camtasia Studio. 

 

Camtasia Recorder: Τν Camtasia Recorder γξάθεη νηηδήπνηε πξνβάιιεηαη ζηελ 

νζφλε ηνπ ππνινγηζηή καο, ζπκπεξηιακβαλνκέλσλ ησλ θηλήζεσλ δξνκέα, επηινγέο 

κελνχ, pop-up παξάζπξα, δαθηπινγξάθεζε θιπ. 
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Δηθφλα 50: Camtasia Recorder. 

 

Camtasia Player: Τν Camtasia Player είλαη έλα απηφλνκν πξφγξακκα 

αλαπαξαγσγήο βίληεν, βειηηζηνπνηεκέλν γηα ηελ αλαπαξαγσγή εγγξαθψλ απφ ηελ 

νζφλε. 

 

Δηθφλα 51: Camtasia Player. 

Camtasia Audio Editor: Τν Camtasia Audio Editor καο επηηξέπεη λα επεμεξ-

γαζηνχκε αξρεία ήρνπ θαη λα δεκηνπξγήζνπκε ερεηηθά εθέ ηα νπνία κπνξνχκε λα 

πξνζζέζνπκε ζε έλα βίληεν. 
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Δηθφλα 52: Camtasia Audio Editor. 

 

Camtasia Theater: Με ην Camtasia Theater κπνξνχκε λα δεκηνπξγήζνπκε έλα 

δηαδξαζηηθφ κελνχ γηα λα μεθηλήζνπλ Flash (.Swf ή .Flv) αξρεία γηα ην Web ή ζε CD-

ROM. Τν Camtasia Theater πξνζζέηεη πινήγεζε φκνηα κε ηνπ DVD, ζε βίληεν ζε 

Flash Format. To κελνχ ηνπ Camtasia Theater επηηξέπεη ζηνπο ρξήζηεο λα πινεγεζνχλ 

ζε πνιιαπιέο ηαηλίεο ή λα δνπλ ηηο ηαηλίεο ζε κηα πξνθαζνξηζκέλε αθνινπζία. 
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Δηθφλα 53: Camtasia Theater 
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Δηθφλα 54: Camtasia MenuMaker 

 

Τν Camtasia Recorder κηα απφ ηηο εθαξκνγέο ηνπ πξνγξάκκαηνο Camtasia 

Studio πξνζθέξεη ηε δπλαηφηεηα θηλεκαηνγξάθεζεο ηεο νζφλεο ηνπ ππνινγηζηή. Τν 

πξφγξακκα δίλεη ηε δπλαηφηεηα λα θαζνξηζζεί εμαξρήο ε πεξηνρή θηλεκαηνγξάθεζεο 

απφ ην ρξήζηε, ζπιιακβάλνληαο ηε δξάζε νιφθιεξεο ηεο νζφλεο ή κηαο νξζνγψληαο 

πεξηνρήο πνπ κπνξεί λα ζρεδηαζζεί κε ην πνληίθη. Σ‟ απηή ηε δηαδηθαζία κπνξεί λα 

ρξεζηκνπνηεζεί ην pen-tablet (ζηπιφ-πνληίθη), έηζη ψζηε φ,ηη ζεκεηψλεηαη ζηελ νζφλε 

ηνπ ππνινγηζηή λα κεηαδίδεηαη σο άκεζε πιεξνθνξία. Δπίζεο κπνξνχκε λα 

ζπλδπάζνπκε θαη θαηαγξαθή ήρνπ απφ ην ζπλδεδεκέλν κηθξφθσλν αιιά θαη ηε ρξήζε 

Video-Cam. Ζ εθαξκνγή πξνζθέξεη επίζεο ηε δπλαηφηεηα θαηαγξαθήο κηαο 

παξνπζίαζεο PowerPoint απεπζείαο κέζα απφ ην ίδην ην πξφγξακκα PowerPoint. 
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Δηθφλα 55: Camtasia Recorder 

 

Τν πιενλέθηεκα ηνπ πξνγξάκκαηνο Camtasia Recorder ζε ζχγθξηζε κε άιια 

πνιπκέζα ίδηαο κνξθήο είλαη ε ζπκπίεζε ησλ δεκηνπξγνχκελσλ αξρείσλ θαηά ηελ 

επηκέιεηά ηνπο δηαηεξψληαο ηελ πνηφηεηα ηνπο ζε πςειά επίπεδα. Ζ εμαηξεηηθήο 

πνηφηεηαο βίληεν νθείιεηαη ζηνλ κε απσιεζηηθφ αιγφξηζκν ζπκπίεζεο TechSmith 

Screen Capture πνπ ρξεζηκνπνηεί ην πξφγξακκα. Βαζηθφ πιενλέθηεκα ηεο εθαξκνγήο 

είλαη ε δεκηνπξγία ζπκπηεζκέλσλ αξρείσλ πςειήο πνηφηεηαο κε δπλαηφηεηα 

ηνπνζέηεζήο ηνπο ζην δηαδίθηπν. 

Ζ θαηαγξαθή ηεο νζφλεο κπνξεί λα γίλεη ζηηο εμήο κνξθέο αξρείσλ: 

 Camtasia Recording File (.camrec): Ηδηφθηεηε κνξθή αξρείνπ ηεο 

TechSmith πνπ ρξεζηκνπνηείηαη γηα ηελ απνζήθεπζε θαηαγξαθήο απφ νζφλε 

θαη θσηνγξαθηθή κεραλή θαζψο θαη κεηαδεδνκέλσλ ζρεηηθά κε ηηο δηάθνξεο 

θαηεγνξίεο ζε έλα εληαίν παθέην. CAMREC είλαη ε πξνεπηιεγκέλε κνξθή 

αξρείνπ θαηαγξαθήο. Αλ ζθνπεχνπκε λα εθαξκφζνπκε SmartFocus θαηά ηε 

δηαδηθαζία ηεο επεμεξγαζίαο θαη ηνπ κνληάδ, θαηαγξάθνπκε θάλνληαο ρξήζε 

ηεο κνξθήο αξρείνπ ηνπ .camrec. 

 Audio Video Interleave (.avi): Φξεζηκνπνηνχκε AVI αξρεία γηα ηνλ άκεζν 

δηακνηξαζκφ ηελ θαηαγξαθήο, εθηφο ηνπ Camtasia Studio. 

Καηά ηε δηάξθεηα ηεο εγγξαθήο κπνξνχκε λα πξνζζέζνπκε θαη εθέ ζρνιηαζκνχ 

φπσο πξνβνιή ηνπ δξνκέα θαη θάπνηνπ αληηθεηκέλνπ, γξαθηθά θαη ζρνιηαζκνχο 
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εηθφλαο, πδαηνγξαθήκαηα, ζεκάλζεηο ρξφλνπ, ιεδάληεο θαη ερεηηθά θιηθ ηνπ 

πνληηθηνχ. Δηδηθφηεξα: 

 System Stamp: Μία έλζεηε ζθξαγίδα θαηαγξαθήο πιεξνθνξηψλ, φπσο ε ψξα 

θαη ε εκεξνκελία, ν ρξφλνο πνπ έρεη παξέιζεη, ην φλνκα ηνπ ππνινγηζηή, θαη 

ην φλνκα ρξήζηε ζηελ ερνγξάθεζε. 

 Caption: Μπνξνχκε λα ρξεζηκνπνηήζνπκε ιεδάληεο γηα λα πξνζζέζνπκε 

πιεξνθνξίεο πλεπκαηηθήο ηδηνθηεζίαο, εηδηθέο νδεγίεο, πξφζζεηεο 

πιεξνθνξίεο θιπ. Ζ ιεηηνπξγία είλαη παξφκνηα κε ην System Stamp, αιιά 

παξέρεη κεγαιχηεξε επειημία. Με ιεδάληεο, κπνξνχκε λα πξνθαζνξίζνπκε ην 

θείκελν ηεο ιεδάληαο, λα ρξεζηκνπνηήζνπκε θείκελα ιεδάληαο πνπ έρνπλ 

δεκηνπξγεζεί πξνεγνπκέλσο ή λα εηζάγνπκε έλα λέν θείκελν ιεδάληαο on-the-

fly. 

 Watermark: Υδαηνγξαθήκαηα είλαη νη εηθφλεο, φπσο ην ινγφηππν ηεο 

εηαηξίαο, πνπ απνηππψλνληαη ζην βίληεν. Μπνξεί λα γίλεη εηζαγσγή κνξθψλ 

αξρείνπ .bmp, .gif, .jpg, and .png σο πδαηνγξαθήκαηα. 

 Highlight an Area: Απηφ ην εθέ πξνζζέηεη έλα ζηαηηθφ πεξίγξακκα γχξσ απφ 

κηα πεξηνρή ή έλα αληηθείκελν θαηά ηελ θαηαγξαθή. Φξεζηκνπνηνχκε ηελ 

επηινγή Highlight γηα λα επηζηήζνπκε ηελ πξνζνρή ζε έλα παξάζπξν, κηα 

γξακκή εξγαιείσλ ή κηα ζπγθεθξηκέλε πεξηνρή ηεο νζφλεο. 

 Mouse click sound or keyboard sound effects: Απηά ηα ερεηηθά εθέ 

πξνζθέξνπλ ηε δπλαηφηεηα λα αλαπαξαρζεί έλαο ήρνο ζηελ ερνγξάθεζε θάζε 

θνξά πνπ θάλνπκε θιηθ ζην θνπκπί ηνπ πνληηθηνχ ή παηάκε έλα πιήθηξν ζην 

πιεθηξνιφγην.
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4 Πολσμεζικό Εκπαιδεσηικό Υλικό 

Ζ ρξήζε απνθιεηζηηθά video ζηελ εθπαηδεπηηθή δηαδηθαζία έρεη νξηζκέλα 

κεηνλεθηήκαηα. Τν κέγεζνο ηνπ παξαγφκελνπ πιηθνχ είλαη αξθεηά κεγάιν θαη 

απαηηείηαη θεηδψ ζηε θαηαγξαθή ελψ ην ίδην ην κέζν δεκηνπξγεί κηα ρξνληθή πίεζε 

ζηνλ καζεηεπφκελν πνπ ζπλήζσο νδεγεί ζε εθηελή ρξήζε ηεο παχζεο (pause) ζηελ 

αλαπαξαγσγή θαη δελ επηηξέπεη ζην καζεηή λα ζπγθεληξσζεί ζην ζέκα.  

 Ωο απνηέιεζκα, θξίλεηαη νξζφηεξε ε κίμε ησλ παξαγψγσλ ηνπ Camtasia κε 

επηπιένλ πιηθφ ζε κνξθή θεηκέλνπ ή/θαη εηθφλσλ θαη ε δεκηνπξγία ελφο ζχλζεηνπ 

εθπαηδεπηηθνχ βνεζήκαηνο.  

 Τελ ηειεπηαία δεθαεηία είδαλ ην θσο αξθεηά ηέηνηα ινγηζκηθά, ηφζν εκπνξηθά φζν 

θαη παξάγσγα εξεπλεηηθψλ πξνγξακκάησλ ζηνλ ηνκέα ηεο ειεθηξνληθήο κάζεζεο. 

Οξηζκέλα απφ απηά πεξηγξάθνληαη ζηε ζπλέρεηα. Οη πεξηζζφηεξεο εθαξκνγέο έρνπλ 

πνιχ απιφ πεξηβάιινλ ρξήζεο ψζηε λα είλαη εχθνιν γηα ηνλ εθπαηδεπηή λα πξνβάιιεη 

εθπαηδεπηηθφ πιηθφ αιιά θαη γηα ηνλ εθπαηδεπφκελν λα ην θαηαλνήζεη πιήξσο. Δπίζεο 

θάπνηα απφ απηά πξνζθέξνπλ αθφκα θαη ηε δπλαηφηεηα δηαρείξηζεο κηαο εηθνληθήο 

ηάμεο θαη ηελ παξαθνινχζεζε ηεο βαζκνινγίαο ησλ καζεηψλ ηεο. 

 Ηδηαίηεξε έκθαζε δίλεηαη ζην eXe, πνπ είλαη θαη ην εξγαιείν πνπ ρξεζηκνπνηήζεθε 

ζην πιαίζην ηεο παξνχζαο πηπρηαθήο εξγαζίαο. 
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4.1 Λογιζμικά Παπαγωγήρ Δκπαιδεςηικού Τλικού 

Τν CourseWebs Learning Management System επηηξέπεη γξήγνξα θαη εχθνια λα 

δεκηνπξγνχληαη online καζήκαηα θαη εμεηάζεηο. Τν LMS επηηξέπεη ζε θάζε 

εθπαηδεπηή λα δεκηνπξγήζεη κηα on-line αίζνπζα πνπ πεξηιακβάλεη εμεηάζεηο θαη 

θνπίδ, θφξνπκ ζπδεηήζεσλ, έλα εκεξνιφγην πνξείαο θ.ά. Δπίζεο επηηξέπεηαη ζηνλ 

εθπαηδεπηή ε δεκηνπξγία θαη ηξνπνπνίεζε ηνπ πεξηερνκέλνπ ησλ καζεκάησλ, ε 

δηαρείξηζε θνηηεηψλ θαη ησλ βαζκψλ ηνπο, θαη πνιιά άιια.  

Τν LAMS είλαη έλα επαλαζηαηηθφ λέν εξγαιείν γηα ην ζρεδηαζκφ, ηε δηαρείξηζε 

θαη ηελ παξνρή ζε απεπζείαο ζχλδεζε ζπλεξγαηηθψλ δξαζηεξηνηήησλ κάζεζεο. 

Παξέρεη ζηνπο εθπαηδεπηηθνχο έλα ηδηαίηεξα δηαηζζεηηθφ νπηηθφ πεξηβάιινλ 

ζπγγξαθήο γηα ηε δεκηνπξγία αθνινπζηψλ ησλ καζεζηαθψλ δξαζηεξηνηήησλ. Απηέο νη 

δξαζηεξηφηεηεο κπνξεί λα πεξηιακβάλνπλ κηα ζεηξά απφ επηκέξνπο εξγαζίεο, κηθξή 

νκαδηθή εξγαζία θαη φιεο ηηο δξαζηεξηφηεηεο κηαο ηάμε κε βάζε ηφζν ην πεξηερφκελν 

φζν θαη ηε ζπλεξγαζία. 

Τν WebLessons είλαη έλα εχθνιν ζηε ρξήζε ζχζηεκα δηαρείξηζεο κάζεζεο πνπ 

κεηαηξέπεη ην ράνο ηνπ Γηαδηθηχνπ ζε έλα αζθαιέο, δνκεκέλν πεξηβάιινλ κάζεζεο 

γηα εζάο θαη ηνπο καζεηέο ζαο. Αληί γηα έλα θαλνληθφ παξάζπξν πξνγξάκκαηνο 

πεξηήγεζεο, ην WebLessons δίλεη ζηνπο θνηηεηέο κηα νξγαλσκέλε, βήκα-βήκα 

κάζεζε, κνλνπάηη κε πιήξεηο νδεγίεο, ζέκαηα ζπνπδψλ, ιεμηιφγην, θνπίδ, θαη έξεπλα 

κε βάζε ηα ζρέδηα. Απφ ηελ πιεπξά ησλ εθπαηδεπηηθψλ, ην WebLessons επηηξέπεη 

ζηνπο θαζεγεηέο λα ζρεδηάζνπλ έλα νινθιεξσκέλν πξφγξακκα ζπνπδψλ ζην 

δηαδίθηπν, λα εθρσξήζεη ηα ζέκαηα, θαη λα παξαθνινπζεί ηελ πξφνδν ησλ θνηηεηψλ. 

Κάζε κάζεκα πεξηιακβάλεη έλαλ νινθιεξσκέλν νδεγφ εθπαηδεπηή κε πξφζζεηνπο 

πφξνπο ηδεψλ ζην Web. 

Τν Articulate θαζηζηά εχθνιν γηα νπνηνλδήπνηε λα πξνζζέζεη δηαδξαζηηθφηεηα 

θαη αθήγεζε ζηηο δηαθάλεηεο ηνπ PowerPoint. Με έλα απιφ θιηθ ζε έλα θνπκπί 

κεηαηξέπεηαη ε παξνπζίαζή ζε πξνβνιή Flash. Πξνζθέξεηαη επίζεο ε εχθνιε θαη 

επαγγεικαηηθή δεκηνπξγία θνπίδ ζε κνξθή Flash θαη εξεπλψλ. Τέινο κεηαηξέπεη 

γξήγνξα ζρεδφλ θάζε βίληεν ζηε δεκνθηιή .FLV Flash κνξθή βίληεν. Μπνξεί λα γίλεη 

εγγξαθή βίληεν, αθφκε θαη απεπζείαο απφ ηελ web cam. 
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Τν OpenAcademic πξνζθέξεη ηηο δπλαηφηεηεο δηαρείξηζεο ηεο ηζηνζειίδαο ελφο 

ζρνιείνπ, θαζψο θαη φιεο ηηο ηζηνζειίδεο ελφο ζπιιφγνπ, δεκηνπξγίαο ελφο ηδησηηθνχ 

ρψξνπ εξγαζίαο, δηαρείξηζεο κηαο ηάμεο, θνηλήο ρξήζεο αξρείσλ. Μπνξεί επίζεο λα 

δψζεη θάπνηνο ζηνπο καζεηέο ηα εξγαιεία πνπ ρξεηάδνληαη γηα ηελ νηθνδφκεζε ησλ 

ραξηνθπιαθίσλ ηνπο φζν ζα δηαζρίδνπλ αθαδεκατθά έηε ζπνπδψλ ελψ παξέρεηαη θαη 

ζηήξημε ηεο επαγγεικαηηθήο εμέιημεο ησλ εθπαηδεπηηθψλ. Τέινο πξνζθέξεηαη 

δπλαηφηεηα επηθνηλσλίαο κε ηνπο γνλείο. 
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4.2 eXe  

To eXe (eLearning XHTML editor) είλαη έλα πξφγξακκα πνπ καο βνεζάεη λα 

θαηαζθεπάζνπκε εχθνια ηζηνζειίδεο. Παιαηφηεξα απηφ απαηηνχζε γλψζεηο XHTML 

ή XML. Με ην eXe φκσο απηά δε ρξεηάδνληαη θαζψο είλαη ζρεδηαζκέλν θπξίσο γηα λα 

βνεζήζεη εθπαηδεπηηθνχο θαη αθαδεκατθνχο πνπ δελ έρνπλ γλψζεηο web ηερλνινγηψλ.  

Με ην eXe κπνξνχκε λα θηηάμνπκε ηζηνζειίδεο πνπ ζα πεξηέρνπλ ζηνηρεία φπσο, 

ζπλδέζκνπο κε άιιεο ζειίδεο, εξσηήζεηο πνιιαπιήο επηινγήο, πνιπκέζα θαη αξρεία 

video απφ ην youtube θιπ.  

Υπάξρνπλ αξθεηέο νκνηφηεηεο ηνπ eXe κε ηα άιια πξνγξάκκαηα ζε φηη αθνξά ηελ 

εθηέιεζε θαη ηελ επεμεξγαζία. Πεξηέρεη εληνιέο φπσο Αληηγξαθή, Απνθνπή, 

Δπηθόιιεζε, Βνήζεηα. 

Ωζηφζν ππάξρνπλ θαη ζηνηρεία πνπ παξαδνζηαθά βξίζθεη θαλείο ζε εθαξκνγέο 

δεκηνπξγίαο ηζηνζειίδσλ. Τέηνηα είλαη: 

εηζαγσγή εηθφλαο,  εηζαγσγή ήρνπ/βίληεν,  

εηζαγσγή νξηδφληηαο γξακκήο απφ πάλσ  
εηζαγσγή καζεκαηηθνχ ζπκβφινπ,  

εηζαγσγή εζσηεξηθνχ ζπλδέζκνπ (anchor) 
δεκηνπξγία ζπλδέζκνπ 

θαηάξγεζε ζπλδέζκνπ  εηζαγσγή ζπκβφινπ 

εηζαγσγή ζπλδέζκνπ κε ηζηνζειίδα ή video απφ ην youtube.  

  

 Όηαλ μεθηλνχκε ην eXe εκθαλίδεηαη ε παξαθάησ εηθφλα.  
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Δηθφλα 56: Τν πεξηβάιινλ εξγαζίαο ηνπ eXe. 

 

Τν eXe έρεη αξθεηέο νκνηφηεηεο κε άιια πξνγξάκκαηα. Σην πάλσ κέξνο ππάξρεη ε 

γξακκή εξγαζηψλ πνπ πεξηιακβάλεη ηέζζεξα κελνχ (θαηαιόγνπο): Αξρείν, Δξγαιεία, 

Σηπι, Βνήζεηα. 

 

Δηθφλα 57 : Γξακκή Μελνχ 

 

Σην Μελνύ -> Αξρείν πεξηιακβάλνληαη νη εληνιέο: Γεκηνπξγία, Άλνηγκα, 

Πξόζθαηα Έξγα, Απνζήθεπζε, Απνζήθεπζε σο, Δθηύπσζε, Δμαγσγή, Σπγρώλεπζε, 

Έμνδνο.  
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Δηθφλα 58 : Δπηινγέο ηνπ Μελνχ Αξρείν 

 

Με ηελ εληνιή Γεκηνπξγία (New), θαηαζθεπάδνπκε έλα λέν αξρείν.  

Με ηελ εληνιή Άλνηγκα, κπνξνχκε λα αλνίμνπκε έλα ήδε απνζεθεπκέλν αξρείν).  

Σηα Πξόζθαηα Έξγα κπνξνχκε λα δνχκε αξρεία πνπ έρνπκε αλνίμεη ή 

επεμεξγαζηεί πξφζθαηα. Απηά παξνπζηάδνληα ζε έλα άιιν κελνχ, πνπ αλνίγεη κφιηο 

πάκε ηνλ θέξζνξα ζην βειάθη δίπια ζηελ εληνιή.  

Με ηελ εληνιή Δθηύπσζε (Print) κπνξνχκε λα εθηππψζνπκε έλα αξρείν.  

Δπηιέγνληαο Απνζήθεπζε, απνζεθεχνπκε φηη αιιαγέο έρνπκε θάλεη ζην αξρείν πνπ 

επεμεξγαδφκαζηε.  

Ζ εληνιή Απνζήθεπζε σο είλαη ίδηα κε ηελ εληνιή Απνζήθεπζε, απιά 

ρξεζηκνπνηείηαη φηαλ απνζεθεχνπκε έλα αξρείν πνπ ην δεκηνπξγνχκε θαη ην 

επεμεξγαδφκαζηε γηα πξψηε θνξά.  

Γηα λα κπνξέζνπκε λα πξνβάιινπκε ηε δηαδηθαζία καο ζην δίθηπν, πξέπεη αθνχ 

ηειεηψζνπκε ηελ επεμεξγαζία ηεο ηζηνζειίδαο λα θάλνπκε Δμαγσγή. Ζ εμαγσγή ελφο 

αξρείνπ κπνξεί λα γίλεη κε δηάθνξνπο ηξφπνπο, δειαδή δηαθνξεηηθνχο ηχπνπο αξρείσλ 

(Απιή ηζηνζειίδα, Αξρείν Κεηκέλνπ θιπ), αλάινγα κε ηη αξρείν ζέινπκε λα 

εηνηκάζνπκε.  

Ζ εληνιή Σπγρώλεπζε πεξηιακβάλεη δχν επηινγέο: εηζαγσγή παθέηνπ, εμαγσγή 

παθέηνπ. Με ηελ εληνιή απηή, κπνξνχκε λα ρσξίζνπκε ή λα ελψζνπκε δηαθνξεηηθά 

αξρεία ή κέξε αξρείσλ (παθέηα).  
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Με ηελ εληνιή Έμνδνο (Quit) θιείλεη ην πξφγξακκα. Δίλαη ν κνλαδηθφο ηξφπνο γηα 

λα θιείζνπκε θάπνην πξφγξακκα ζην eXe δηφηη δελ ηζρχεη, φπσο ζε άιιεο εθαξκνγέο, 

ην θιηθ πάλσ ζην . 

Σην Μελνύ -> Δξγαιεία (Tools) ππάξρνπλ νη παξαθάησ εληνιέο: Δπεμεξγαζηήο 

ειεθηξνληθήο Γξαζηεξηφηεηαο (idevice network), Πξνηηκήζεηο (Preferences) θαη 

Αλαλέσζε (Refresh Display).  

 

Δηθφλα 59 : Δπηινγέο ηνπ Μελνχ Δξγαιεία 

 

Ο επεμεξγαζηήο ειεθηξνληθήο δξαζηεξηόηεηαο (πνπ ιέγεηαη θαη ειεθηξνληθό 

εξγαιείν) καο βνεζάεη λα βγάδνπκε δηάθνξα ζηνηρεία (ηηο δξαζηεξηφηεηεο), πνπ 

κπνξνχκε λα βάινπκε ζηελ ηζηνζειίδα. Τέηνηα κπνξεί λα είλαη απιφ θείκελν, εηθφλεο, 

ζπλδέζκνπο άιιεο εθαξκνγέο θιπ.  

Όηαλ αλνίγνπκε ηνλ επεμεξγαζηή, αλνίγεη έλα λέν παξάζπξν πνπ καο βνεζάεη λα 

δεκηνπξγήζνπκε κηα θαηλνχξηα δξαζηεξηφηεηα ή λα επεμεξγαζηνχκε κηα πνπ έρνπκε 

δεκηνπξγήζεη απφ πξηλ. 

Με ηελ εληνιή Πξνηηκήζεηο κπνξνχκε λα αιιάμνπκε ηε γιψζζα ηεο εθαξκνγήο. 

Απιά φηαλ ηελ παηήζνπκε, εκθαλίδεηαη έλα παξάζπξν κε κία ιίζηα απφ γιψζζεο. 

Δπηιέγνπκε ηε γιψζζα πνπ ζέινπκε θαη κεηά παηάκε OK.  
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Δηθφλα 60 : Δπηινγή Πξνηηκήζεηο 

 

Με ηελ Αλαλέσζε κπνξνχκε λα έρνπκε ηε ζειίδα ελεκεξσκέλε κε ηηο ηειεπηαίεο 

αιιαγέο πνπ έρνπκε θάλεη. 

Ο θαηάινγνο Σηπι καο δίλεη θάπνηεο επηινγέο γηα ηελ εκθάληζε ηεο ζειίδαο.  

Ο θαηάινγνο Βνήζεηα πεξηέρεη πιεξνθνξίεο θαη εγρεηξίδην γηα ηε ρξήζε ηνπ 

πξνγξάκκαηνο.  

Ζ απνζήθεπζε ελφο αξρείνπ απφ ην eXe γίλεηαη πεξίπνπ φπσο ζε άιιεο 

εθαξκνγέο. Γχν ελέξγεηεο είλαη ζρεηηθέο κε ηελ απνζήθεπζε ηνπ αξρείνπ. Ζ κία είλαη 

ε «Απνζήθεπζε» θαη ε άιιε είλαη ε «Δμαγσγή». 

Κάζε θνξά πνπ επηιέγνπκε ηελ εληνιή Απνζήθεπζε / Απνζήθεπζε σο, εκθαλίδεηαη 

έλα παξάζπξν πνπ καο επηηξέπεη λα δηαιέμνπκε πνχ ζα απνζεθεπηεί ην αξρείν θαη κε 

ηη φλνκα. Έηζη δεκηνπξγείηαη έλα αξρείν ηεο κνξθήο "παθέην πεξηερνκέλνπ IMS" ην 

νπνίν ζα κπνξνχκε λα αλνίμνπκε θαη λα επεμεξγαζηνχκε μαλά.  

Όηαλ απνζεθεχνπκε έλα αξρείν ζα πξέπεη λα πξνζέρνπκε ψζηε ν θάθεινο πνπ 

επηιέγνπκε (γηα ηελ απνζήθεπζε) αιιά θαη φινη νη θάθεινη ζηνπο νπνίνπο απηφο 

πεξηέρεηαη λα έρνπλ Λαηηληθνύο ραξαθηήξεο.  

Παράδειγμα: 

Σ‟ απηή ηελ πεξίπησζε απνζεθεχνπκε ζην θάθειν eXe test ελψ ε „δηαδξνκή‟ ηνπ 

είλαη C:\Documents and Setting\user\My Documents\eXe\project. Βιέπνπκε φηη έρνπκε 

κφλν ιαηηληθνχο ραξαθηήξεο, φρη κφλν ζην θάθειν πνπ απνζεθεχνπκε αιιά θαη ζε 

φινπο ηνπο θαθέινπο πνπ απηφο βξίζθεηαη (path).  
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Σηελ πεξίπησζε απηή βιέπνπκε φηη ζε θάπνην ζεκείν ηεο δηαδξνκήο 

C:\Documents and Setting\karen\Τα έγγξαθά κνπ\eXe\project ν θάθεινο «ηα έγγξαθά 

κνπ» έρεη Διιεληθνύο xαξαθηήξεο θαη δελ καο επηηξέπεη λα απνζεθεχζνπκε 

Όηαλ ζέινπκε λα αλνίμνπκε ην αξρείν, αλνίγνπκε ην πξφγξακκα θαη δηαιέγνπκε 

απφ ην κελνχ ηελ εληνιή Άλνηγκα ή ην επηιέγνπκε απφ ηα Πξόζθαηα Έγγξαθα 

Σπλήζσο ην απνζεθεπκέλν αξρείν δελ αλνίγεη αλ πάκε ζην θάθειν ηνπ θαη 

θάλνπκε δηπιφ θιηθ, φπσο γίλεηαη κε άιιεο εθαξκνγέο  

Γηα λα απνζεθεχζνπκε ην αξρείν σο ηζηνζειίδα, ζα πξέπεη λα πάκε ζην κελνχ 

Αξρείν, Δμαγσγή. Τν κελνχ απηφ παξνπζηάδεη δηάθνξεο επηινγέο. Μπνξνχκε λα 

επηιέμνπκε Ηζηφηνπνο, Common Cartridge, θιπ.  

 

Δηθφλα 61 : Δπηινγή Δμαγσγή  

 

Ζ ζπγθεθξηκέλε εληνιή ζα δεκηνπξγήζεη ζηνλ ππνινγηζηή έλα θάθειν (directory), 

ην φλνκά ηνπ θαζψο θαη ηελ ηνπνζεζία ηνπ, ηελ νπνία ζα έρνπκε θαζνξίζεη εκείο θαηά 

ηελ απνζήθεπζε, φπσο γίλεηαη θαη ζε άιιεο εθαξκνγέο.  

Αλνίγνληαο απηφ θάθειν βιέπνπκε πνιιά άιια αξρεία. Αλάκεζά ηνπο ζα δνχκε 

θαη έλα κε ην φλνκα index. Τν αξρείν ζα έρεη ηνλ ηχπν ηνπ πξνγξάκκαηνο πεξηήγεζεο 

ζην ίληεξλεη (internet explorer, mozilla firefox) θαη ζπγθεθξηκέλα εθείλν πνπ ππάξρεη 

σο πξνεπηινγή ζηνλ ππνινγηζηή.  

Με δηπιφ θιηθ ζ‟ απηφ αλνίγεη ην αξρείν. Θα αλνίμεη κε ηε κνξθή ηζηνζειίδαο θαη 

δελ ζα κπνξνχκε λα θάλνπκε αιιαγέο.  

Μηα απφ ηηο επηινγέο πνπ καο δίλεη ην κελνχ είλαη θαη ε εμαγσγή σο «Παθέην 

Πεξηερνκέλνπ IMS». Οπζηαζηηθά απηφ είλαη ε ίδην κε ηελ απνζήθεπζε.  

 Κάησ απφ ηε γξακκή κε ηα βαζηθά κελνχ, ζηα αξηζηεξά, ππάξρεη έλα πιαίζην ζην 

νπνίν αλαπαξίζηαηαη ην Πεξίγξακκα ηεο ηζηνζειίδαο πνπ ζα θηηάμνπκε.  
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 Μφιηο αλνίμνπκε ην πξφγξακκα, ην πιαίζην κε ην πεξίγξακκα πεξηέρεη κφλν ηελ 

Αξρή. Με ηηο εληνιέο πάλσ απφ ηε γξακκή κπνξνχκε λα θάλνπκε επεμεξγαζία.  

Αλ καξθάξνπκε ηελ Αξρή θαη παηήζνπκε Πξνζζήθε ζειίδαο, κπνξνχκε λα 

βάινπκε επηπιένλ ζειίδεο. Αλ ηηο καξθάξνπκε θαη παηήζνπκε Γηαγξαθή, ζα ηηο 

βγάινπκε, ελψ αλ παηήζνπκε Μεηνλνκαζία, ζα ηνπο αιιάμνπκε φλνκα.  

Μαξθάξνληαο κηα απφ ηηο ζειίδεο πνπ δεκηνπξγήζακε θαη παηψληαο Πξνζζήθε 

ζειίδαο κπνξνχκε λα δεκηνπξγήζνπκε ππν-ζειίδεο.  

Με ηα βειάθηα πνπ είλαη θάησ απφ ην πιαίζην ηνπ πεξηερνκέλνπ κπνξνχκε λα 

αιιάμνπκε ηε ζεηξά. Γηα λα γίλεη απηφ πξέπεη λα καξθάξνπκε ην θεθάιαην πνπ 

ζέινπκε λα βάινπκε ζε άιιε ζεηξά θαη κεηά λα παηήζνπκε ην εηθνλίδην, ην βειάθη ηεο 

επηινγήο καο.  

 

Δηθφλα 62 : Μεηνλνκαζία Σειίδαο 
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4.3 Σα Web ΢ςζηαηικά ηος eXe 

Οη εθπαηδεπηηθέο δξαζηεξηφηεηεο (iDevices) παξέρνπλ έλα πιαίζην κέζα ζην νπνίν 

νξίδεηε ην πεξηερφκελφ ζαο. Ωο δξαζηεξηφηεηα κπνξεί λα νξηζηεί κηα εξγαζία ή έλα 

ζχλνιν εξγαζηψλ πνπ πξέπεη λα νινθιεξψζεη έλαο καζεηήο.  

Γηα λα βάινπκε κηα δξαζηεξηφηεηα ζηε ζειίδα, ρξεηάδεηαη λα κεηαθηλήζνπκε ηνλ 

θέξζνξα ζηε ιίζηα, ηνλ πίλαθά ηνπο (iDevices pane) θαη λα καξθάξνπκε απηή πνπ 

ζέινπκε.    

Παηψληαο ην εηθνλίδην  κπνξνχκε λα θάλνπκε ηελ επεμεξγαζία.  

Ηδηαίηεξε πξνζνρή ρξεηάδεηαη ζε θάπνηα ζεκεία ηεο επεμεξγαζίαο ηνπ θεηκέλνπ, 

πνπ πεξηέρεη θάζε δξαζηεξηφηεηα. Πάλσ απφ ην πιαίζην θεηκέλνπ ππάξρεη ην 

παξαθάησ κελνχ.  

 

Δηθφλα 63 : Δξγαιεηνζήθε Δπεμεξγαζίαο 

 

 Κάπνηεο απφ ηηο δξαζηεξηφηεηεο αλαθέξνληαη παξαθάησ: 

RSS = Τν RSS (Really Simple Syndication) βνεζά λα πάξνπκε πιεξνθνξίεο απφ κία 

ηζηνζειίδα ρσξίο λα ρξεηάδεηαη λα κπνχκε ζ‟ απηήλ. Γξάθνπκε ηε δηεχζπλζε ηεο 

ζειίδαο (URL) ζην ζρεηηθφ πιαίζην θαη αληινχληαη νη πιεξνθνξίεο κε ηε θφξησζε.   

Άξζξν Βίθη (Wiki Article)  =  Βνεζά λα πάξνπκε άξζξα απφ ηε Βηθηπαίδεηα θαη λα ηα 

βάινπκε ζην αξρείν καο. Φξεηάδεηαη θπζηθά λα ππάξρεη ζχλδεζε ζην ίληεξλεη.  

 

Γθαιεξί εηθόλσλ (Image gallery) = Βνεζά λα αλεβάζνπκε εηθφλεο.  

 

Γξαζηεξηόηεηα Αλάγλσζεο (Reading activity) = Γίλεη ηελ επθαηξία λα ζηήζνπκε κηα 

αλαγλσζηηθή άζθεζε, πεξηγξάθνληαο ιίγα βαζηθά πξάγκαηα κε αλαθνξέο ζηελ αξρή, 

κεηά ηε δξαζηεξηφηεηα θαη ηέινο ηα βαζηθά ζεκεία (αλαηξνθνδφηεζε).  

 

Διεύζεξε Γξαζηεξηόηεηα (Activity) = Βνεζά λα βάινπκε κηα δξαζηεξηφηεηα ηεο 

αξεζθείαο καο. Γίλεηαη απιά πεξηγξαθή ησλ δξάζεσλ πνπ πξέπεη λα γίλνπλ.  
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Διεύζεξν Κείκελν (Free Text Area) = Βνεζά ζηελ απιή πεξηγξαθή ηνπ ζέκαηνο ηνπ 

αξρείνπ καο, δίλεη νδεγίεο γηα ηα θείκελα, ηηο δξαζηεξηφηεηεο πνπ βάδνπκε θιπ.  

 

Δμσηεξηθόο Γηαδηθηπαθόο Τόπνο (External website) = Βνεζά λα βάδνπκε ζπλδέζκνπο 

κε άιιεο ηζηνζειίδεο ζην θείκελφ καο. Έηζη κπνξνχκε λα αλνίγνπκε ηηο ζειίδεο απηέο, 

ρσξίο λα ρξεηάδεηαη λέν παξάζπξν.  

 

Δξώηεζε Σσζηνύ –Λάζνπο (True/False Question) = Βάδεη εξσηήζεηο πνπ αλαθέξνπλ 

κηα δήισζε θαη απαηηεί απφ ηνλ αλαγλψζηε, ηνλ επηζθέπηε, ην καζεηή λα απνθαζίζεη 

εάλ είλαη αιεζηλή ή ςεπδήο. 

 

Δξώηεζε Πνιιαπιήο Δπηινγήο (Multi-choice Question) = Βνεζά λα βάδνπκε 

εξσηήζεηο κε δηάθνξεο πηζαλέο ζσζηέο απαληήζεηο.  

 

Κνπΐδ ηύπνπ SCORM (SCORM Quiz) = Ζ δξαζηεξηφηεηα απηή παξέρεη ηε δπλαηφηεηα 

λα βάδνπκε εξσηήζεηο κε πηζαλέο απαληήζεηο (πνιιαπιήο επηινγήο). Ζ δηαθνξά εδψ 

φκσο είλαη φηη κε ηε βνήζεηα ελφο ζπζηήκαηνο γίλεηαη ππνινγηζκφο πφλησλ/βαζκψλ 

αλάινγα κε ηελ απάληεζε πνπ επηιέγεηαη.  

 

Μειέηε Πεξίπησζεο (Case Study) = Με ηε δξαζηεξηφηεηα απηή κπνξνχκε λα βάινπκε 

ζην αξρείν καο έλα θείκελν πνπ ζα έρεη θάπνην βαζηθφ, εθπαηδεπηηθφ κήλπκα.  

Αλαθέξεηαη ζε πξαγκαηηθέο θαηαζηάζεηο πνπ εθαξκφδνληαη ζεσξίεο ζηελ πξάμε.  

Μηθξνεθαξκνγή Java (Java Applet) = Βνεζά λα βάινπκε εθαξκνγέο Java ζην αξρείν  

 

Σπκπιήξσζεο Κελώλ (Cloze Activity)  =  Βνεζά λα βάδνπκε θείκελν κε θελά πνπ 

πξέπεη λα ζπκπιεξσζνχλ. Πξφθεηηαη γηα δεκνθηιή ηχπν άζθεζεο. 
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5 Πολσμεζικά Μαθήμαηα ACAD 

5.1 Οπγάνωζη Μαθημάηων  

Γηα κηα ζσζηή θαη απνηειεζκαηηθή νξγάλσζε ησλ καζεκάησλ, θαηαγξάθνπκε αξρηθά 

ηηο απαηηήζεηο ηεο εθαξκνγήο απηνδηδαζθαιίαο. Τν εθπαηδεπηηθφ πιηθφ πξέπεη λα 

είλαη θαηαλνεηφ, θηιηθφ πξνο ηνλ ρξήζηε, απιφ, εχρξεζην θαη λα κπνξεί λα 

επαλαρξεζηκνπνηεζεί. Ζ εθαξκνγή πξέπεη λα  έρεη έλαλ  εληαίν ηξφπν πεξηγξαθήο ηνπ 

καζεζηαθνχ πιηθνχ γηα εχθνιε αλαδήηεζε θαη γξήγνξε αλάθηεζε πιεξνθνξηψλ. 

Δπίζεο ζα πξέπεη λα ππάξρεη δπλαηφηεηα απφ θνηλνχ ρξήζεο εθαξκνγήο, δειαδή λα 

πξνζθέξεη ηνπιάρηζηνλ φιεο ηηο δπλαηφηεηεο  πνπ πξνζθέξεη θαη ε εθπαίδεπζε ζηελ 

θιαζηθή ηάμε. 

 Σηε ζπλέρεηα ζα πξέπεη λα γίλεη ζσζηή θαηαλνκή ηνπ εθαπηδεπηηθνχ πιηθνχ 

ζχκθσλα κε ην βαζκφ δπζθνιίαο θαη ηνλ ζπληειεζηή βαξχηεηάο ηνπ. Γίλεηαη 

θαηαθεξκαηηζκφο ζε ππνελφηεηεο θαη νξίδεηαη ν αξηζκφο σξψλ πνπ απαηηεί ε θάζε 

ελφηεηα γηα ζσζηή θαη απνηειεζκαηηθή δηδαζθαιία πξνβιέπνληαο πάληα ηηο 

δπζθνιίεο πνπ ελδερνκέλσο ζα αληηκεησπίζεη ν καζεηήο. 

 Αθνινπζεί ρξήζε παξαδεηγκάησλ, ζπλνδεπφκελσλ απφ εηθφλεο, θείκελα 

πεξηγξαθήο θαη ζε θάπνηεο πεξηπηψζεηο θαη video γηα λα είλαη πην απνηειεζκαηηθφ θαη 

εχρξεζην ην πιηθφ πνπ παξάγεηαη. 

 Τέινο, παξνπζηάδεηαη ην πην ζεκαληηθφ κέξνο ηεο εθαξκνγήο απηνδηδαζθαιίαο, νη 

αζθήζεηο. Ζ ρξήζε ιπκέλσλ θαη άιπησλ αζθήζεσλ δηαθφξσλ κνξθψλ (πνιιαπιήο 

επηινγήο, ζσζηνχ-ιάζνπο, αληηζηνίρεζεηο θαη αλάπηπμεο) θαη κηθξήο δηάξθεηαο ηεζη 

βνεζάλε ζηελ θαηάιιειε πξνεηνηκαζίαο ηνπ καζεηή. 
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5.2 Παπάδειγμα 

 Τν πιηθφ ζηελ απηνεθπαίδεπζε έρεη δνκεκέλε κνξθή κε θεθάιαηα, ππνθεθάιαηα 

θαη παξαγξάθνπο, ηα νπνία νη καζεηέο πξέπεη λα αθνινπζήζνπλ ζηε ζεηξά. 

 

Απνηειείηαη απφ πινχζην πιηθφ πνιπκέζσλ (video θαη εηθφλεο), ή απιφ θείκελν πνπ 

δηαβάδνπλ νη καζεηεπφκελνη. 

 

Δηθφλα 64 : Γφκεζε θεθαιαίσλ, ππνθεθαιαίσλ θαη παξαγξάθσλ 
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Δηθφλα 65 : Οξγάλσζε καζήκαηνο 
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Πεξηέρεη επίζεο αζθήζεηο, ηεζη θαη εξγαζίεο φπνπ νη καζεηεπφκελνη κπνξνχλ λα ζπκκεηάζρνπλ είηε απφ ην ζπίηη ηνπο, είηε απφ ηνλ ρψξν 

εξγαζίαο.  

 

Δηθφλα 66 : Παξνπζίαζε Αζθήζεσλ 
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5.3 Γιδακηική Αξιοποίηζη ηηρ ACAD VBA 

Ζ Visual Basic for Application (VBA) είλαη κηα εμεηδηθεπκέλε κνξθή ηεο γιψζζαο 

πξνγξακκαηηζκνχ Microsoft Visual Basic. Γεκηνπξγήζεθε κε βάζε ηελ γλσζηή Basic 

θαη ρξεζηκνπνηεί πιεζψξα ηδίσλ ή παξφκνησλ ραξαθηεξηζηηθψλ θαη παξφκνην 

ζρεδηαζηηθφ πεξηβάιινλ. 

Ο πξνγξακκαηηζκφο ηεο VBA δηαθέξεη απφ ηνλ αληίζηνηρν ηεο Ms VB ζε αξθεηά 

ζεκεία. Γηα παξάδεηγκα ηα εξγαιεία πνπ ρξεζηκνπνηνχληαη ζηηο πεξηζζφηεξεο 

πεξηπηψζεηο έρνπλ παξαπιήζηα νλφκαηα αιιά φρη ίδηα. 

Τν VBA ρξεζηκνπνηείηαη γηα ηελ ζρεδίαζε δηαθφξσλ αληηθεηκέλσλ κε ρξήζε 

θψδηθα κέζσ ηνπ Visual Basic Editor ηνπ ζρεδηαζηηθνχ πξνγξάκκαηνο AutoCAD, αληί 

λα ζρεδηάζνπκε κε ηνπο γλσζηνχο ηξφπνπο πνπ αλαθέξζεθαλ ζηηο παξαπάλσ 

ελφηεηεο. Απηφ θαηά θχξην ιφγν γίλεηαη κε ηε δεκηνπξγία καθξνεληνιψλ ζε γιψζζα 

VB. 

Γηα λα ηξέρνπκε θάπνην θνκκάηη θψδηθα αθνινπζνχκε ηελ δηαδξνκή Tools -> 

Macro -> Visual Basic Editor ή παηάκε ηα πιήθηξα Alt+F11 θαη ακέζσο εκθαλίδεηαη 

ην παξαθάησ πιαίζην: 

 

Δηθφλα 67 : Δπεμεξγαζηήο Visual Basic 

 

Αλ πιεθηξνινγήζνπκε ηνλ θψδηθα ζηε δεμηά κεξηά ηνπ παξαζχξνπ (εηθφλα 62) ην 

απνζεθεχνπκε θαη κπνξνχκε λα ην ρξεζηκνπνηήζνπκε θαη αθνχ θιείζνπκε ην 

παξάζπξν απηφ, κέζσ ηνπ AutoCAD Tools -> Macro-> Macro. 
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Παξάδεηγκα, πιεθηξνινγνχκε ην παξαθάησ θνκκάηη θψδηθα ην νπνίν δεκηνπξγεί 

κηα γξακκή (line): 

Public Sub TestAddLine() 

Dim varStart As Variant 

Dim varEnd As Variant 

Dim objEnt As AcadLine 

On Error Resume Next 

'' get input from user 

With ThisDrawing.Utility 

varStart = .GetPoint(, vbCr & "Pick the start point: ") 

varEnd = .GetPoint(varStart, vbCr & "Pick the end point: ") 

End With 

'' draw the entity 

If ThisDrawing.ActiveSpace = acModelSpace Then 

Set objEnt = ThisDrawing.ModelSpace.AddLine(varStart, varEnd) 

Else 

Set objEnt = ThisDrawing.PaperSpace.AddLine(varStart, varEnd) 

End If 

objEnt.Update 

End Sub 

θαη ην παξαθάησ θνκκάηη θψδηθα ειέγρεη εάλ ππάξρεη θάπνην ζρεδηαζκέλν 

αληηθείκελν θαη ηαπηφρξνλα δείρλεη ηηο δηαζηάζεηο ηνπ αληηθεηκέλνπ. 

Sub Ch2_FindFirstEntity() 

  ' This example returns the first entity in model space 

     On Error Resume Next 

  Dim entity As AcadLine 

   

If ThisDrawing.ModelSpace.Count <> 0 Then 

       Set entity = ThisDrawing.ModelSpace.Item(0) 
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       MsgBox entity.ObjectName + _ 

        " is the first entity in model space." 

 

MsgBox "This line has a start point of " & entity.StartPoint(0) & ", " 

& entity.StartPoint(1) & ", " & entity.StartPoint(2) & " and an endpoint of " 

& entity.EndPoint(0) & ", " & entity.EndPoint(1) & ", " & entity.EndPoint(2), 

vbInformation, "StartPoint Example" 

Else 

        MsgBox "There are no objects in model space." 

    End If 

End Sub 

 

Δπίζεο κπνξνχκε λα ειέγμνπκε εάλ ππάξρνπλ παξαπάλσ απφ έλα ζρεδηαζκέλα 

αληηθείκελα. Τξέρνπκε ην παξαθάησ θνκκάηη θψδηθα ην νπνίν εκθαλίδεη έλα πιαίζην 

κε ηα νλφκαηα φισλ ησλ ζρεδηαζκέλσλ αληηθεηκέλσλ κε ηε ζεηξά πνπ ζρεδηάζηεθαλ. 

Private Sub CommandButton_Click() 

On Error Resume Next 

Dim entity As AcadEntity 

Dim count As Double 

count = ThisDrawing.ModelSpace.count 

If count <> 0 Then 

For I = 0 To count - 1 

Set entity = ThisDrawing.ModelSpace.Item(I) 

MsgBox entity.ObjectName + _ " exists in model space." 

Next I 

Else 

MsgBox "There are no objects in model space." 
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End If 

End Sub 

 

Όηαλ ην ηξέμνπκε θαη  δελ ζα ππάξρεη θαλέλα αληηθείκελν ζα εκθαλίζεη ην κήλπκα 

"There are no objects in model space." 

Θα ην ηξέμνπκε μαλά αθνχ έρνπκε δεκηνπξγήζεη θάπνην αληηθείκελν θαη ζα πξέπεη 

λα καο ιέεη ην φλνκα ηνπ αληηθεηκέλνπ. 

Σηηο παξαθάησ εηθφλεο θαίλεηαη ε θάζε πεξίπησζε πνπ αλαθέξακε πην πάλσ: 

 

Δηθφλα 68 : Έιεγρνο γηα αληηθείκελα 
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Δηθφλα 69 : Έιεγρνο γηα χπαξμε θχθινπ 

 

Σην παξάζπξν ζρεδίαζεο ηνπ AutoCAD θαίλεηαη πσο εθηφο απφ ηνλ θχθιν 

ππάξρεη θαη κηα γξακκή ζρεδηαζκέλε. Αθνχ εκθαλίζεη ην πξψην παξαζπξάθη πνπ καο 

ελεκεξψλεη πσο ππάξρεη ην αληηθείκελν θχθινο θαη παηήζνπκε OK ηφηε εκθαλίδεη έλα 

άιιν παξαζπξάθη ην νπνίν καο ελεκεξψλεη γηα ηελ γξακκή. 

Παξαθάησ θαίλεηαη ε αληίζηνηρε εηθφλα: 
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Δηθφλα 70 : Έιεγρνο γηα χπαξμε γξακκήο 
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6 Σσμπεράζμαηα - Μελλονηική Εργαζία 

 Οη ξαγδαίεο εμειίμεηο ζηνλ ηερλνινγηθφ ηνκέα, θαζψο επίζεο θαη νη νινέλα 

απμαλφκελεο απαηηήζεηο ηεο ζχγρξνλεο δσήο, θαζηζηνχλ δσηηθήο ζεκαζίαο ηελ 

αλάγθε γηα ζπλερή εθπαίδεπζε θαη θαηάξηηζε, νχησο ψζηε λα κπνξέζεη ν άλζξσπνο 

λα ζπκβαδίζεη κε ηηο εμειίμεηο απηέο. Τν αζθπθηηθφ φκσο σξάξην ηνπ ζχγρξνλνπ 

αλζξψπνπ θαζηζηά πνιχ δχζθνιν ην έξγν απηφ. Γηα ην ιφγν απηφ ε απηνεθπαίδεπζε 

δίλεη ηελ δπλαηφηεηα ζηνλ καζεηεπφκελν λα πξνζαξκφζεη ηελ εθπαίδεπζή ηνπ ζην 

δηθφ ηνπ θαζεκεξηλφ ξπζκφ. Οπφηε θαζίζηαηαη θαλεξή ε αλαγθαηφηεηα χπαξμεο 

εθπαηδεπηηθνχ πιηθνχ, ην νπνίν ζα θαιχπηεη ηελ αλάγθε απηή ηνπ ζχγρξνλνπ 

αλζξψπνπ. 

 Σηελ παξνχζα πηπρηαθή κε βάζε εθπαηδεπηηθφ πιηθφ παξαδνζηαθήο εθπαίδεπζεο 

(ζεκεηψζεηο ACAD θαη άιιεο πεγέο άληιεζεο πιεξνθνξίαο ζρεηηθά κε ην ACAD) 

δεκηνπξγήζεθε κηα πνιπκεζηθή εθαξκνγή απηνδηδαζθαιίαο κε ζέκα “Σρεδίαζε 2D κε 

ην ACAD”.  

 Ζ εθαξκνγή απηή απνηειείηαη αθελφο απφ ην ζεσξεηηθφ θνκκάηη, ζην νπνίν 

πεξηγξάθεηαη ην ζρεδηαζηηθφ πξφγξακκα ACAD, θάλνληαο αλαθνξά ζηηο πην 

ζεκαληηθέο ιεηηνπξγίεο ηνπ θαη αθεηέξνπ απφ ην πξαθηηθφ θνκκάηη, ην νπνίν 

απνηειείηαη απφ ιπκέλεο θαη άιπηεο αζθήζεηο, κέζσ ησλ νπνίσλ ν καζεηεπφκελνο 

κπνξεί λα απηναμηνινγεζεί.. Δπίζεο, έλα ζεκαληηθφ θνκκάηη ηεο εθαξκνγήο απηήο 

είλαη ην VBA, κε ηε βνήζεηα ηνπ νπνίνπ κπνξεί λα γίλεη έιεγρνο ηνπ επηπέδνπ 

θαηάξηηζεο ηνπ καζεηεπνκέλνπ θαη ησλ πξνβιεκάησλ ηα νπνία αληηκεησπίδεη. Τέινο, 

ε εθαξκνγή εκπινπηίδεηαη κε videos ηα νπνία πεξηγξάθνπλ θαη εμεγνχλ κε 

ιεπηνκέξεηα ηηο ιεηηνπξγίεο ηνπ πξνγξάκκαηνο, γηα θαιχηεξα απνηειέζκαηα θαη 

δηεπθφιπλζε πξνο ηνλ καζεηεπφκελν. 

 Δίλαη ζεκαληηθφ φκσο λα ηνληζηεί πσο ππάξρνπλ δηαθφξσλ εηδψλ πξνβιήκαηα 

φζσλ αθνξά ηελ απηνδηδαζθαιία. Παξφιε ηελ εμέιημε ηεο ηειεθπαίδεπζεο πξέπεη λα 

αλαθεξζεί πσο έλα ζεκαληηθφ πνζνζηφ ηνπ πιεζπζκνχ δελ θαηέρεη ηηο θαηάιιειεο 

γλψζεηο θαη ηνλ θαηάιιειν εμνπιηζκφ, ζεσξψληαο ηα είδε πνιπηειείαο. 
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 Όζν αθνξά ηελ απηνδηδαζθαιία ηνπ ζρεδηαζηηθνχ πξνγξάκκαηνο AutoCAD αμίδεη 

λα δνζεί ηδηαίηεξε ζεκαζία ζηε γιψζζα πξνγξακκαηηζκνχ VBA θαη ζηηο δπλαηφηεηεο 

πνπ πξνζθέξεη. Αλαγλσξίδεη πιεζψξα γεγνλφησλ ηνπ καζεηή, ειέγρεη ηη έρεη 

δεκηνπξγήζεη ν καζεηήο είηε κέζσ θψδηθα είηε κε ηνλ απιφ ηξφπν ζρεδίαζεο ζην  

AutoCAD. Σε κηα κειινληηθή πηπρηαθή εξγαζία ζα κπνξνχλ λα κειεηεζνχλ φιεο νη 

δπλαηφηεηεο πνπ πξνζθέξεη ην  VBA, νη νπνίεο πνηθίινπλ ζχκθσλα κε ηηο απαηηήζεηο 

καο, φπσο ην λα ειέγρεη εάλ ν καζεηήο έρεη δεκηνπξγήζεη φηη ηνπ δεηήζεθε, ζε ηη 

επίπεδν ηεο εξγαζίαο βξίζθεηαη, εάλ θαηαγξάθεθαλ δπζθνιίεο θαηά ηελ δηάξθεηα 

αλάπηπμεο εθαξκνγήο θ.α. 

 Καηά ηελ δηάξθεηα αλάπηπμεο ηεο εθαξκνγήο απηήο πξνέθπςαλ δηάθνξα 

πξνβιήκαηα, ηα πνιπκεζηθά θείκελα απαηηνχλ ηδηαίηεξε πξνζνρή έηζη ψζηε λα είλαη 

θαηαλνεηά πξνο ηνλ καζεηή. Δπίζεο θαη ηα video έρνπλ έλα ζεκαληηθφ βαζκφ 

δπζθνιίαο, ην χθνο πνπ παξνπζηάδεηαη ην ζέκα, ν ηφλνο ηεο θσλήο, θαζνξίδνπλ ην 

ζπληειεζηή βαξχηεηαο. Υπήξμαλ φκσο θαη αξθεηά ηερληθά πξνβιήκαηα θαηά ηελ 

δηάξθεηα θαηαγξαθήο ηνπο, ε ιχζε ησλ νπνίνλ ήηαλ ιίγν ρξνλνβφξα. 

 Σηελ επνρή καο φκσο ε αλάγθε γηα απφθηεζε γλψζεσλ απμάλεηαη ζεκαληηθά, 

πξέπεη λα κάζνπκε πνιιά ζε ιίγν ρξφλν. Ζ αλάγθε απηή καο αλαγθάδεη λα 

μεπεξάζνπκε θάζε δπζθνιία πνπ ππάξρεη ζηνλ ηξφπν απηνδηδαζθαιίαο θαη λα 

αλαδεηνχκε θαιχηεξεο θαη γξεγνξφηεξεο ιχζεηο. Ο ηνκέαο ηεο απηνδηδαζθαιίαο καο 

θαιχπηεη ηελ αλάγθε λα απνθηήζνπκε πιεξνθνξία γξήγνξα θαη εχθνια, θεξδίδνληαο 

ρξφλν θαη ρξήκα. 

 Σαθέζηαηα είλαη αθφκα λσξίο λα θξίλνπκε ηελ εμέιημή ηεο θαη ηηο πηζαλφλ 

παξελέξγεηέο ηεο, ζίγνπξα φκσο κπνξνχκε λα παξαδερηνχκε φηη είλαη έλα ζεκαληηθφ 

θνκκάηη ζηνλ ηξφπν δσήο καο. 
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Παράρηημα 

Καηεγνξίεο δηδαζθαιίαο εθπαηδεπηηθνχ πιηθνχ θαη εξγαιεία πνπ αλήθνπλ ζηηο 

θαηεγνξίεο απηέο. 

 

Δξγαιεία παξαγσγηθφηεηαο (Productivity tools (personal and group)) 

 Calculators 

 Calendars, Event & Meeting Scheduling 

 Performance Support, EPSS and Help Desk tools 

 Mapping tools 

 Note Taking/Sharing and Whiteboard tools 

 Personal Information Managers / GTD Organisers  

 Personal Productivity tools 

 (Re)search tools 

 

Δξγαιεία Φαξηνγξάθεζεο Ηδεψλ (Mind mapping tools) 

 Mind mapping and brainstorming tools 

 

Δξγαιεία Παξνπζίαζεο (Presentation tools) 

 Presentation tools 

 Charting tools 

 

Δξγαιεία ηεθκεξίσζεο θαη παθέηα γξαθείνπ (Documentation and office suites) 

 Office (document/spreadsheet) tools and suites 

 Document hosting and sharing tools 

 E-Book tools 

 PDF converters and editors 

Δθπαηδεπηηθά εξγαιεία  (Instructional tools) 

http://c4lpt.co.uk/Directory/Tools/calculators.html
http://c4lpt.co.uk/Directory/Tools/calendar.html
http://c4lpt.co.uk/Directory/Tools/epss.html
http://c4lpt.co.uk/Directory/Tools/maps.html
http://c4lpt.co.uk/Directory/Tools/notes.html
http://c4lpt.co.uk/Directory/Tools/pims.html
http://c4lpt.co.uk/Directory/Tools/personal.html
http://c4lpt.co.uk/Directory/Tools/research.html
http://c4lpt.co.uk/Directory/Tools/mind.html
http://c4lpt.co.uk/Directory/Tools/presentation.html
http://c4lpt.co.uk/Directory/Tools/chart.html
http://c4lpt.co.uk/Directory/Tools/wp.html
http://c4lpt.co.uk/Directory/Tools/docs.html
http://c4lpt.co.uk/Directory/Tools/ebook.html
http://c4lpt.co.uk/Directory/Tools/pdfconverters.html
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 Course authoring tools 

 Interactivity tools 

 Quizzing and testing  tools 

 Mobile learning authoring tools 

 Study Pack creators 

 

Δξγαιεία ζχιιεςεο νζφλεο (Screen capture and screncasting tools) 

 Screen capture, screencasting and software demo tools 

 Learning games and simulation  tools 

 

Δξγαιεία βίληεν  (Video tools) 

 Video/flash hosting and sharing sites 

 

Σπζηήκαηα δηαρείξηζεο καζεκάησλ (Course management systems) 

 Course & Learning (Content) Management System 

 Gradebook tools 

 

http://c4lpt.co.uk/Directory/Tools/authoring.html
http://c4lpt.co.uk/Directory/Tools/interactivity.html
http://c4lpt.co.uk/Directory/Tools/testing.html
http://c4lpt.co.uk/Directory/Tools/mlearning.html
http://c4lpt.co.uk/Directory/Tools/study.html
http://c4lpt.co.uk/Directory/Tools/capture.html
http://c4lpt.co.uk/Directory/Tools/games.html
http://c4lpt.co.uk/Directory/Tools/video.html
http://c4lpt.co.uk/Directory/Tools/coursemgt.html
http://c4lpt.co.uk/Directory/Tools/gradebook.html

